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Chapter 1

1. Introduction

Fully updated for Android Studio 2.3 and Android 7, the goal of this book is to teach the skills
necessary to develop Android based applications using the Android Studio Integrated
Development Environment (IDE) and the Android 7 Software Development Kit (SDK).

Beginning with the basics, this book provides an outline of the steps necessary to set up an Android
development and testing environment. An overview of Android Studio is included covering areas such
as tool windows, the code editor and the Layout Editor tool. An introduction to the architecture of
Android is followed by an in-depth look at the design of Android applications and user interfaces using
the Android Studio environment. More advanced topics such as database management, content
providers and intents are also covered, as are touch screen handling, gesture recognition, camera
access and the playback and recording of both video and audio. This edition of the book also covers
printing, transitions and cloud-based file storage.

The concepts of material design are also covered in detail, including the use of floating action buttons,
Snackbars, tabbed interfaces, card views, navigation drawers and collapsing toolbars.

In addition to covering general Android development techniques, the book also includes Google Play
specific topics such as implementing maps using the Google Maps Android API, in-app billing and
submitting apps to the Google Play Developer Console.

The key new features of Android Studio and Android 7 are also covered in detail including the new
Layout Editor, the ConstraintLayout and ConstraintSet classes, constraint chains, direct reply
notifications, Firebase remote notifications and multi-window support.

Chapters also cover advanced features of Android Studio such as Gradle build configuration and the
implementation of build variants to target multiple Android device types from a single project code
base.

Assuming you already have some Java programming experience, are ready to download Android
Studio and the Android SDK, have access to a Windows, Mac or Linux system and ideas for some apps
to develop, you are ready to get started.

1.1 Downloading the Code Samples

The source code and Android Studio project files for the examples contained in this book are available
for download at:
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http://www.ebookfrenzy.com/direct/androidstudio23/index.php
The steps to load a project from the code samples into Android Studio are as follows:

1. From the Welcome to Android Studio dialog, select the Open an existing Android Studio project
option.

2. In the project selection dialog, navigate to and select the folder containing the project to be
imported and click on OK.

1.2 Feedback

We want you to be satisfied with your purchase of this book. If you find any errors in the book, or have
any comments, questions or concerns please contact us at feedback@ebookfrenzy.com.

1.3 Errata

While we make every effort to ensure the accuracy of the content of this book, it is inevitable that a
book covering a subject area of this size and complexity may include some errors and oversights. Any
known issues with the book will be outlined, together with solutions, at the following URL:

http://www.ebookfrenzy.com/errata/androidstudio23.htm/

In the event that you find an error not listed in the errata, please let us know by emailing our technical
support team at feedback@ebookfrenzy.com. They are there to help you and will work to resolve any
problems you may encounter.


http://www.ebookfrenzy.com/direct/androidstudio23/index.php
mailto:feedback@ebookfrenzy.com
http://www.ebookfrenzy.com/errata/androidstudio23.html
mailto:feedback@ebookfrenzy.com

Chapter 2

2. Setting up an Android Studio
Development Environment

Before any work can begin on the development of an Android application, the first step is to
configure a computer system to act as the development platform. This involves a number of steps
consisting of installing the Java Development Kit (JDK) and the Android Studio Integrated Development
Environment (IDE) which also includes the Android Software Development Kit (SDK).

This chapter will cover the steps necessary to install the requisite components for Android application
development on Windows, Mac OS X and Linux based systems.

2.1 System Requirements
Android application development may be performed on any of the following system types:

e Windows 7/8/10 (32-bit or 64-bit)

e Mac OS X 10.10 or later (Intel based systems only)

e Linux systems with version 2.19 or later of GNU C Library (glibc)
e Minimum of 2GB of RAM (8GB is preferred)

e Approximately 4GB of available disk space

e 1280 x 800 minimum screen resolution

2.2 Installing the Java Development Kit (JDK)

The Android SDK was developed using the Java programming language. Similarly, Android applications
are also developed using Java. As a result, the Java Development Kit (JDK) is the first component that
must be installed.

Android Studio development requires the installation of version 8 of the Standard Edition of the Java
Platform Development Kit. Java is provided in both development (JDK) and runtime (JRE) packages.
For the purposes of Android development, the JDK must be installed.

2.2.1 Windows JDK Installation

For Windows systems, the JDK may be obtained from Oracle Corporation’s website using the following
URL:
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http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html

Assuming that a suitable JDK is not already installed on your system, download version 8 of the JDK
package that matches the destination computer system. Once downloaded, launch the installation
executable and follow the on screen instructions to complete the installation process.

2.2.2 Mac OS X JDK Installation

Java is not installed by default on recent versions of Mac OS X. To confirm the presence or otherwise

of Java, open a Terminal window and enter the following command:

java -version

Assuming that Java is currently installed, output similar to the following will appear in the terminal
window:

java version "1.8.0 77"
Java (TM) SE Runtime Environment (build 1.8.0 77-b03)
Java HotSpot (TM) 64-Bit Server VM (build 25.77-b03, mixed mode)

In the event that Java is not installed, issuing the “java” command in the terminal window will result
in the appearance of a message which reads as follows together with a dialog on the desktop providing
a More Info button which, when clicked will display the Oracle Java web page:

No Java runtime present, requesting install

On the Oracle Java web page, locate and download the Java SE 8 JDK installation package for Mac OS
X.

Open the downloaded disk image (.dmg file) and double-click on the icon to install the Java package
(Figure 2-1):

- JDK 8 Update 77

Java Development Kit

Double-click on icon to install

JDK 8 Update 77.pkg

Figure 2-1
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The Java for OS X installer window will appear and take you through the steps involved in installing the
JDK. Once the installation is complete, return to the Terminal window and run the following command,
at which point the previously outlined Java version information should appear:

java -version

2.3 Linux JDK Installation

First, if the chosen development system is running the 64-bit version of Ubuntu then it is essential that
a 32-bit library support package be installed:

sudo apt-get install 1ib32stdc++6

As with Windows based JDK installation, it is possible to install the JDK on Linux by downloading the
appropriate package from the Oracle web site, the URL for which is as follows:

http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html|

Packages are provided by Oracle in RPM format (for installation on Red Hat Linux based systems such
as Red Hat Enterprise Linux, Fedora and CentOS) and as a tar archive for other Linux distributions such
as Ubuntu.

On Red Hat based Linux systems, download the .rpm JDK file from the Oracle web site and perform
the installation using the rom command in a terminal window. Assuming, for example, that the
downloaded JDK file was named jdk-8u77-linux-x64.rpom, the commands to perform the installation
would read as follows:

su
rpm —ihv jdk-8u77-linux-x64.rpm

To install using the compressed tar package (tar.gz) perform the following steps:

1. Create the directory into which the JDK is to be installed (for the purposes of this example we will
assume /home/demo/java).

2. Download the appropriate tar.gz package from the Oracle web site into the directory.

3. Execute the following command (where <jdk-file> is replaced by the name of the downloaded JDK
file):

tar xvfz <jdk-file>.tar.gz
4. Remove the downloaded tar.gz file.

5. Add the path to the bin directory of the JDK installation to your SPATH variable. For example,
assuming that the JDK ultimately installed into /home/demo/java/jdk1.8.0_77 the following would
need to be added to your SPATH environment variable:


http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
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/home/demo/java/jdkl.8.0 77/bin

This can typically be achieved by adding a command to the .bashrc file in your home directory (specifics
may differ depending on the particular Linux distribution in use). For example, change directory to
your home directory, edit the .bashrc file contained therein and add the following line at the end of
the file (modifying the path to match the location of the JDK on your system):

export PATH=/home/demo/java/jdkl.8.0 77/bin:$PATH

Having saved the change, future terminal sessions will include the JDK in the SPATH environment
variable.

2.4 Downloading the Android Studio Package

Most of the work involved in developing applications for Android will be performed using the Android
Studio environment. The content and examples in this book were created based on Android Studio
version 2.3.

Android Studio is subject to frequent updates and it is possible, therefore, that a more recent release
of Android Studio is now available. For the purposes of compatibility with the tutorials and examples,
however, it is recommended that this book be used with Android Studio version 2.3 which may be
downloaded from the following web page:

http://tools.android.com/download/studio/builds/2-3-0

From this page, select and download the appropriate package for your platform and operating system.

2.5 Installing Android Studio

Once downloaded, the exact steps to install Android Studio differ depending on the operating system
on which the installation is being performed.

2.5.1 Installation on Windows

Locate the downloaded Android Studio installation executable file (named android-studio-bundle-
<version>.exe) in a Windows Explorer window and double-click on it to start the installation process,
clicking the Yes button in the User Account Control dialog if it appears.

Once the Android Studio setup wizard appears, work through the various screens to configure the
installation to meet your requirements in terms of the file system location into which Android Studio
should be installed and whether or not it should be made available to other users of the system. When
prompted to select the components to install, make sure that the Android Studio, Android SDK and
Android Virtual Device options are all selected.

Although there are no strict rules on where Android Studio should be installed on the system, the
remainder of this book will assume that the installation was performed into C:\Program
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Files\Android\Android Studio and that the Android SDK packages have been installed into the user’s
AppData\Local\Android\sdk sub-folder. Once the options have been configured, click on the Install
button to begin the installation process.

On versions of Windows with a Start menu, the newly installed Android Studio can be launched from
the entry added to that menu during the installation. The executable may be pinned to the task bar
for easy access by navigating to the Android Studio\bin directory, right-clicking on the executable and
selecting the Pin to Taskbar menu option. Note that the executable is provided in 32-bit (studio) and
64-bit (studio64) executable versions. If you are running a 32-bit system be sure to use the studio
executable.

2.5.2 Installation on Mac 0OS X

Android Studio for Mac OS X is downloaded in the form of a disk image (.dmg) file. Once the android-
studio-ide-<version>.dmg file has been downloaded, locate it in a Finder window and double-click on
it to open it as shown in Figure 2-2:

®0e t= Android Studio 2.0

2

Android Studio Applications

Figure 2-2

To install the package, simply drag the Android Studio icon and drop it onto the Applications folder.
The Android Studio package will then be installed into the Applications folder of the system, a process
which will typically take a few minutes to complete.

To launch Android Studio, locate the executable in the Applications folder using a Finder window and
double-click on it. When attempting to launch Android Studio, an error dialog may appear indicating
that the JVM cannot be found. If this error occurs, it will be necessary to download and install the Mac
OS X Java 6 JRE package on the system. This can be downloaded from Apple using the following link:

http://support.apple.com/kb/DL1572

Once the Java for OS X package has been installed, Android Studio should launch without any
problems.


http://support.apple.com/kb/DL1572
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For future easier access to the tool, drag the Android Studio icon from the Finder window and drop it
onto the dock.

2.5.3 Installation on Linux

Having downloaded the Linux Android Studio package, open a terminal window, change directory to
the location where Android Studio is to be installed and execute the following command:

unzip /<path to package>/android-studio-ide-<version>-linux.zip

Note that the Android Studio bundle will be installed into a sub-directory named android-studio.
Assuming, therefore, that the above command was executed in /home/demo, the software packages
will be unpacked into /home/demo/android-studio.

To launch Android Studio, open a terminal window, change directory to the android-studio/bin sub-
directory and execute the following command:

./studio.sh

On Linux it may also be necessary to specify the location of the Java Development Kit using the
following steps:

Launch Android Studio and create a new project.

Select the File -> Other Settings -> Default Project Structure... menu option.

Enter the full path to the directory containing the JDK into the JDK Location field.
Click Apply followed by OK.

A wnN e

2.6 The Android Studio Setup Wizard

The first time that Android Studio is launched after being installed, a dialog will appear providing the
option to import settings from a previous Android Studio version. If you have settings from a previous
version and would like to import them into the latest installation, select the appropriate option and
location. Alternatively, indicate that you do not need to import any previous settings and click on the
OK button to proceed.

Next, the setup wizard may appear as shown in Figure 2-3 though this dialog does not appear on all
platforms:
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£ ) Welcome
H Android Studio

Welcome! This wizard will set up your development environment for Android Studio.
Additionally, the wizard will help port existing Android apps into Android Studio
or create a new Android application project.

"C)O =N

Cancel Previous Finish

Figure 2-3

If the wizard appears, click on the Next button, choose the Standard installation option and click on
Next once again.

Android Studio will proceed to download and configure the latest Android SDK and some additional
components and packages. Once this process has completed, click on the Finish button in the
Downloading Components dialog at which point the Welcome to Android Studio screen should then
appear:

® Welcome to Android Studio — b4

o

Android Studio

Version 2.3

1% Start a new Android Studio project

1 Open an existing Android Studie project
¥ Check out project from Version Control ~
Lif Import project (Eclipse ADT, Gradle, etc.)

LY Import an Android code sample

#* Configure = GetHelp +

Figure 2-4

2.7 Installing Additional Android SDK Packages

The steps performed so far have installed Java, the Android Studio IDE and the current set of default
Android SDK packages. Before proceeding, it is worth taking some time to verify which packages are
installed and to install any missing or updated packages.
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This task can be performed using the Android SDK Settings screen, which may be launched from within
the Android Studio tool by selecting the Configure -> SDK Manager option from within the Android
Studio welcome dialog. Once invoked, the Android SDK screen of the default settings dialog will appear
as shown in Figure 2-5:

¥ Default Settings *
@ )| Appearance & Behavior > System Settings > Andraid SDK
Appearance & Behavior Manager for the Android SDK and Tools used by Android Studio
Appearance Android SDK Location: | C:\Users\Neil\AppData\Local\Andreid\5dk Edit

e Tl SDK Platforms | SDK Tools | SDK Update Sites

System Settings Each Android SDK Platform package includes the Android platform and sources pertaining to an AP level by

Passwords default. Once installed, Android Studic will automatically check for updates. Check "show package details" to

HTTP Prony display individual SDK components.

Name AP Level Revision Status
Updates Android 7.1.1 (Nougat) 25 3 Installed
Usage Statistics Android 7.0 (Mougat) 24 2 Installed
— Android N Preview N 3 Partially installed
Andrid 60 (Marshmalow) 2 ; Installed
i [ Android 5.1 (Lellipop) 2 2 Not installed
D Android 5.0 (Lollipop) 21 2 Partially installed
Quick Lists () Android 4.4W (KitKat Wear) 20 2 Not installed
Path Variables [ Android 4.4 (KitKat) 19 4 Not installed
[CJ Android 4.3 (Jelly Bean) 18 2 Not installed
Keymap 1 Andrnid 4.7 (lalhe Raan 17 a Nt inctallad
Editor [ Show Package Details
Plugins

| o« IR || Hep |

Figure 2-5

Immediately after installing Android Studio for the first time it is likely that only the latest released
version of the Android SDK has been installed. To install preview or older versions of the Android SDK
simply select the checkboxes corresponding to the versions and click on the Apply button.

It is also possible that updates will be listed as being available for the latest SDK. To access detailed
information about the packages that are available for update, enable the Show Package Details option
located in the lower right-hand corner of the screen. This will display information similar to that shown

in Figure 2-6:
Name APl Level | Revision Status
[=] Android 6.0
Android 6.0 Platform 23 1 Installed
[ Android TV ARM EABI v7a System Image 23 2 Mat installed
[ Android TV Intel %36 Atom System Image 23 2 Mot installed
[] ARMEABI vTa System Image 23 3 Mot installed
[ Intel x86 Atom Systemn Image 23 4 Mot installed
[ Intel x86 Atom_64 System Image 23 4 ::x
=] Google Apis, Android 23 23 1 Update Available: 1
[ Google APls ARM EABI vTa Systemn Image 23 7 i
Google APls Intel x86 Atom System Image 23 8 Installed
[ Google APls Intel x86 Atormn_64 System Image 23 8 Mot installed
_ Sources for Android 23 23 1 Installed
Figure 2-6

The above figure highlights the availability of an update. To install the updates, enable the checkbox
to the left of the item name and click on the Apply button.
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In addition to the Android SDK packages, a number of tools are also installed for building Android

applications. To view the currently installed packages and check for updates, remain within the SDK

settings screen and select the SDK Tools tab as shown in Figure 2-7:

»

| 1z ~

(Q ) App e & Behavior » System Settings > Android SDK
| Appearance & Behavior Manager for the Android SDK and Tools used by Android Studio
Appearance Android 5DK Location: | G\Users\Neil\AppData\Local\Android\Sdk Edit

Menus and Toolbars SDK Platforms{__SDK Tuuls)‘ SDK Update Sites

| System Settings Below are the available SDK developer tools, Once installed, Android Studio will automatically check for updates,

Passwords Check "show package details” to display available versions of an SDK Toal.
HTTP Proxy Name Version Status
Android SDK Build-Tools Installed
Updates ["] GPU Debugging tools Not Installed
Usage Statistics [ CMake Mot Installed
— [ LLDB Mot Installed
] Android Aute API Simulators 1 Mot installed
Motifications () Android Auto Desktop Head Unit emulator 11 Mot installed
o Android Emulator 2331 Installed
Quick Lists Android SDK Platform-Tools 25.0.3 2503 Installed
Path Variables Android SDK Tools 253.1 Installed
Documentation for Android SDK 1 Installed
Keymap [] Google Play APK Expansion library 1 Not installed
Editor Google Play Billing Library 5 Installed
["1 Gonale Plav licensina | ihrans 1 Mot installed
Plugins

D Show Package Details
Build, Execution, Deployment

m ‘ Cancel | ‘ | ‘ Help

Figure 2-7

Within the Android SDK Tools screen, make sure that the following packages are listed as Installed in

the Status column:

Android SDK Build-tools

Android SDK Tools

Android SDK Platform-tools

Android Emulator

Android Support Repository

ConstraintLayout for Android

Solver for ConstraintLayout

Google Repository

Google USB Driver (Windows only)

Intel x86 Emulator Accelerator (HAXM installer)

In the event that any of the above packages are listed as Not Installed or requiring an update, simply

select the checkboxes next to those packages and click on the Apply button to initiate the installation

process.

Once the installation is complete, review the package list and make sure that the selected packages

are now listed as Installed in the Status column. If any are listed as Not installed, make sure they are

selected and click on the Apply button again.
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2.8 Making the Android SDK Tools Command-line Accessible

Most of the time, the underlying tools of the Android SDK will be accessed from within the Android
Studio environment. That being said, however, there will also be instances where it will be useful to
be able to invoke those tools from a command prompt or terminal window. In order for the operating
system on which you are developing to be able to find these tools, it will be necessary to add them to
the system’s PATH environment variable.

Regardless of operating system, the PATH variable needs to be configured to include the following
paths (where <path_to_android_sdk_installation> represents the file system location into which the
Android SDK was installed):

<path to android sdk installation>/sdk/tools
<path to android sdk installation>/sdk/tools/bin
<path to android sdk installation>/sdk/platform-tools

The location of the SDK on your system can be identified by launching the Standalone SDK Manager
and referring to the Android SDK Location: field located at the top of the settings panel as highlighted
in Figure 2-8:

Appearance 8 Behavior » System Settings > Android SDK

Manager for the Android 5DK and Tools used by Android Studio

Android SDK Loclifion: | Ch\Users\Neil\AppDatatLocal\Androidisdk ___: Edit

SDK Platforms | SDK Tools | SDK Update Sites |

Each Android SDK Platform package includes the Android platform and sources pertaining to an AP| level by
default. Once installed, Android Studio will autematically check for updates. Check "show package details” to
display individual SDK components.

Figure 2-8

Once the location of the SDK has been identified, the steps to add this to the PATH variable are
operating system dependent:

2.8.1 Windows 7

1. Right-click on Computer in the desktop start menu and select Properties from the resulting
menu.

2. Inthe properties panel, select the Advanced System Settings link and, in the resulting dialog,
click on the Environment Variables... button.

3. Inthe Environment Variables dialog, locate the Path variable in the System variables list, select it
and click on Edit.... Locate the end of the current variable value string and append the path to
the Android platform tools to the end, using a semicolon to separate the path from the
preceding values. For example, assuming the Android SDK was installed into
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C:\Users\demo\AppData\Local\Android\sdk, the following would be appended to the end of the
current Path value:

;C:\Users\demo\AppData\Local\Android\sdk\platform-tools;
C:\Users\demo\AppData\Local\Android\sdk\tools;
C:\Users\demo\AppData\Local\Android\sdk\tools\bin

4. Click on OK in each dialog box and close the system properties control panel.

Once the above steps are complete, verify that the path is correctly set by opening a Command Prompt
window (Start -> All Programs -> Accessories -> Command Prompt) and at the prompt enter:

echo %Path%

The returned path variable value should include the paths to the Android SDK platform tools folders.
Verify that the platform-tools value is correct by attempting to run the adb tool as follows:

adb

The tool should output a list of command line options when executed.

Similarly, check the tools path setting by attempting to launch the SDK Manager command line tool:
avdmanager

Inthe event that a message similar to the following message appears for one or both of the commands,
it is most likely that an incorrect path was appended to the Path environment variable:

'adb' is not recognized as an internal or external command,

operable program or batch file.

2.8.2 Windows 8.1

1. Onthe start screen, move the mouse to the bottom right-hand corner of the screen and select
Search from the resulting menu. In the search box, enter Control Panel. When the Control Panel
icon appears in the results area, click on it to launch the tool on the desktop.

2. Within the Control Panel, use the Category menu to change the display to Large Icons. From the
list of icons select the one labeled System.

3. Follow the steps outlined for Windows 7 starting from step 2 through to step 4.

Open the command prompt window (move the mouse to the bottom right-hand corner of the
screen, select the Search option and enter cmd into the search box). Select Command Prompt from
the search results.

Within the Command Prompt window, enter:

echo %$Path%

13
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The returned path variable value should include the paths to the Android SDK platform tools folders.
Verify that the platform-tools value is correct by attempting to run the adb tool as follows:

adb
The tool should output a list of command line options when executed.

Similarly, check the tools path setting by attempting to run the AVD Manager command line tool:

avdmanager

Inthe event that a message similar to the following message appears for one or both of the commands,
it is most likely that an incorrect path was appended to the Path environment variable:

'adb' is not recognized as an internal or external command,

operable program or batch file.

2.8.3 Windows 10

Right-click on the Start menu, select System from the resulting menu and click on the Advanced system
settings option in the System window. Follow the steps outlined for Windows 7 starting from step 2
through to step 4.

2.8.4 Linux

On Linux this will involve once again editing the .bashrc file. Assuming that the Android SDK bundle
package was installed into /home/demo/Android/sdk, the export line in the .bashrc file would now
read as follows (allowing for differences in the JDK path):

export
PATH=/home/demo/java/jdkl.8.0/bin:/home/demo/Android/sdk/platform-
tools:/home/demo/Android/sdk/tools: /home/demo/Android/sdk/tools/bin:/h
ome/demo/android-studio/bin:$SPATH

Note also that the above command adds the android-studio/bin directory to the PATH variable. This
will enable the studio.sh script to be executed regardless of the current directory within a terminal
window.

2.8.5 Mac0OS X

A number of techniques may be employed to modify the SPATH environment variable on Mac OS X.
Arguably the cleanest method is to add a new file in the /etc/paths.d directory containing the paths to
be added to SPATH. Assuming an Android SDK installation location of
/Users/demo/Library/Android/sdk, the path may be configured by creating a new file named android-
sdk in the /etc/paths.d directory containing the following lines:

/Users/demo/Library/Android/sdk/tools
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/Users/demo/Library/Android/sdk/tools/bin
/Users/demo/Library/Android/sdk/platform-tools

Note that since this is a system directory it will be necessary to use the sudo command when creating
the file. For example:

sudo vi /etc/paths.d/android-sdk

2.9 Updating the Android Studio and the SDK

From time to time new versions of Android Studio and the Android SDK are released. New versions of
the SDK are installed using the Android SDK Manager. Android Studio will typically notify you when an
update is ready to be installed.

To manually check for Android Studio updates, click on the Configure -> Check for Updates menu
option within the Android Studio welcome screen, or use the Help -> Check for Update menu option
accessible from within the Android Studio main window.

2.10 Summary

Prior to beginning the development of Android based applications, the first step is to set up a suitable
development environment. This consists of the Java Development Kit (JDK), Android SDKs, and Android
Studio IDE. In this chapter, we have covered the steps necessary to install these packages on Windows,
Mac OS X and Linux.
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Chapter 3

3. Creating an Example Android App in
Android Studio

he preceding chapters of this book have covered the steps necessary to configure an environment
Tsuitable for the development of Android applications using the Android Studio IDE. Before moving
on to slightly more advanced topics, now is a good time to validate that all of the required
development packages are installed and functioning correctly. The best way to achieve this goal is to
create an Android application and compile and run it. This chapter will cover the creation of a simple
Android application project using Android Studio. Once the project has been created, a later chapter
will explore the use of the Android emulator environment to perform a test run of the application.

3.1 Creating a New Android Project

The first step in the application development process is to create a new project within the Android
Studio environment. Begin, therefore, by launching Android Studio so that the “Welcome to Android
Studio” screen appears as illustrated in Figure 3-1:

# Welcome to Android Studio — x

)

Android Studio

Start a new Android Studio project

Open an existing Android Studio project
¥ Check out project from Version Control +

Import project (Eclipse ADT, Gradle, etc.)

Import an Android code sample
4 Configure ~  Get Help ~

Figure 3-1
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Once this window appears, Android Studio is ready for a new project to be created. To create the new
project, simply click on the Start a new Android Studio project option to display the first screen of the
New Project wizard as shown in Figure 3-2:

® Creste New Project >

) New Project
Android Studio

Configure your new project

Application name: | My Application] ]

Company Domain: | chaokrenzy.com ]

Packagename  com.ebookfrenzy.myapplication Edit

Project location: | C:\Users\Ne S WORK\MyApplication I

(o) I (] ]
Figure 3-2
3.2 Defining the Project and SDK Settings

In the New Project window, set the Application name field to AndroidSample. The application name is
the name by which the application will be referenced and identified within Android Studio and is also
the name that will be used when the completed application goes on sale in the Google Play store.

The Package Name is used to uniquely identify the application within the Android application
ecosystem. Although this can be set to any string that uniquely identifies your app, it is traditionally
based on the reversed URL of your domain name followed by the name of the application. For example,
if your domain is www.mycompany.com, and the application has been named AndroidSample, then
the package name might be specified as follows:

com.mycompany.androidsample

If you do not have a domain name you can enter any other string into the Company Domain field, or
you may use ebookfrenzy.com for the purposes of testing, though this will need to be changed before
an application can be published:

com.ebookfrenzy.androidsample
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The Project location setting will default to a location in the folder named AndroidStudioProjects located
in your home directory and may be changed by clicking on the button to the right of the text field
containing the current path setting.

Click Next to proceed. On the form factors screen, enable the Phone and Tablet option and set the
minimum SDK setting to APl 14: Android 4.0 (IceCreamSandwich). The reason for selecting an older
SDK release is that this ensures that the finished application will be able to run on the widest possible
range of Android devices. The higher the minimum SDK selection, the more the application will be
restricted to newer Android devices. A useful chart (Figure 3-3) can be viewed by clicking on the Help
me choose link. This outlines the various SDK versions and API levels available for use and the
percentage of Android devices in the marketplace on which the application will run if that SDK is used
as the minimum level. In general it should only be necessary to select a more recent SDK when that
release contains a specific feature that is required for your application.

To help in the decision process, selecting an API level from the chart will display the features that are
supported at that level.

% Android Platforen/A9! Version Distribution

ANDROID PLATFORM API LEVEL CUMULATIVE

VFRSION DISTRIBUTION

) 97.3%

50 15 94.8%

44 16 _ 860%
42 Al 7 Uick each Android Version/AP1 level for more information.

U A 74.3%

70.9%

19

35.4%
5.0 ) 21 i
51 22

1.3%

Figure 3-3

Since the project is not intended for Google TV, Android Auto or wearable devices, leave the remaining
options disabled before clicking Next.

3.3 Creating an Activity

The next step is to define the type of initial activity that is to be created for the application. A range of
different activity types is available when developing Android applications. The Empty, Master/Detail
Flow, Google Maps and Navigation Drawer options will be covered extensively in later chapters. For
the purposes of this example, however, simply select the option to create a Basic Activity. The Basic
Activity option creates a template user interface consisting of an app bar, menu, content area and a
single floating action button.
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® Create New Project

H Add an Activity to Mobile

Add No Activity

Basic Activity Bottom Navigation Activity
Empty Activity Fullscreen Activity Google AdMob Ads Activity

| Previous | [[gancal | [ Fan |

Figure 3-4
With the Basic Activity option selected, click Next. On the final screen (Figure 3-5) name the activity
and title AndroidSampleActivity. The activity will consist of a single user interface screen layout which,
for the purposes of this example, should be named activity_android_sample as shown in Figure 3-5
and with a menu resource named menu_android_sample:

® Create New Project X

Customize the Activity

Creates a new blank activity with an app bar.

- :

_ Activity Name: | AndroidsampleActivity ]
Layout Name: | activity_endroid_sample |
Title: | ctivity |

Menu Resource Name: | menu_android_sample |

Use a Fragment
g1

Blank Activity

The name of the activity class to create

Previous Next Cancel m

Figure 3-5

Finally, click on Finish to initiate the project creation process.
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3.4 Modifying the Example Application

At this point, Android Studio has created a minimal example application project and opened the main

window.

wigte Code Aale Befactor fuid Byn Took VC§ Wndow Heln
o®a T ouiGm il Fod?

sres Eimyout 5 contert andrand samgiemil

© Archodamplehchtyjam * | & content_smdrond

Puiette
]

Wdgets
Test

* 3 et

Design | Ten

uemge HTemns 5 nowaswete 2 1000
(20 Gradebuh Fvishec i 195 86ma 1 miatos gl

Figure 3-6

¥iBouks\ Android Studo 2.3 - & 3 ] fap] - aps ardiced camplesen - Andecrd Sudio 1.3 Beta 2

Okemss- mi35- Onordiorsn Dianpage- D

The newly created project and references to associated files are listed in the Project tool window
located on the left-hand side of the main project window. The Project tool window has a number of
modes in which information can be displayed. By default, this panel will be in Android mode. This
setting is controlled by the menu at the top of the panel as highlighted in Figure 3-7. If the panel is not

currently in Android mode, use the menu to switch mode:

O EO « 4+ rn\ﬁ’!

L4 AndroidSample

=

Y &)
2

5 Android
Project

Packages
Scratche

Android
“Project Files
Problems
Production

Tests

Tests

Android Instrumentation Tests

=1 7: Structuga, | 4 11 P

Captures

-

idsample
pidsampl

idsample

Figure 3-7

The example project created for us when we selected the option to create an activity consists of a user

interface containing a label that will read “Hello World!” when the application is executed.
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The next step in this tutorial is to modify the user interface of our application so that it displays a larger
text view object with a different message to the one provided for us by Android Studio.

The user interface design for our activity is stored in a file named activity_android_sample.xml which,
in turn, is located under app -> res -> layout in the project file hierarchy. This layout file includes the
app bar (also known as an action bar) that appears across the top of the device screen (marked A in
Figure 3-8) and the floating action button (the email button marked B). In addition to these items, the
activity_android_sample.xml layout file contains a reference to a second file containing the content
layout (marked C):

(B J=)

< o] [m}

Figure 3-8

By default, the content layout is contained within a file named content_android_sample.xml and it is
within this file that changes to the layout of the activity are made. Using the Project tool window,
locate this file as illustrated in Figure 3-9:

3 | | ProjectFiles | = Problems b @ s | % I~

app
manifests

jave
Hres

drawable
layout
S activity_android_samplexmi
menu
mipmap
values

= Gradle Scripts

Figure 3-9

Once located, double-click on the file to load it into the user interface Layout Editor tool which will
appear in the center panel of the Android Studio main window:
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© AndroidSempleActivityjava * | 8 content_android_semplexml x |

Palette Q -1~ [ B Al & [Onewss- mbas- Dinoacionsar @Hianguage~ Hl- Properties JEr
Al b TextView ® 15| x g ‘B-|=- I Quz@ @ W & o 1
Widgets 8% Button s
Text ] ToggleButton c 1 o m 0 sm an 7m o an fo 1100 layout width | match_parent | -
Ty Checklion layout_height | matc’hiparent

Containers (® RadioButton

Images ‘v CheckedTextView
< S b4 FE]
Date = Spinner
Transitians © ProgressBar 2
Advanced = ProgressBar (Horizontal)

Component Tree -2

v ¥ Constraintlayout =

Ab TextView

View all properties =

T esin el
Figure 3-10

In the toolbar across the top of the Layout Editor window is a menu (currently set to Nexus 5 in the
above figure) which is reflected in the visual representation of the device within the Layout Editor
panel. A wide range of other device options are available for selection by clicking on this menu.

To change the orientation of the device representation between landscape and portrait simply use the

drop down menu immediately to the right of the device selection menu showing the o icon.

As can be seen in the device screen, the content layout already includes a label that displays a “Hello
World!” message. Running down the left-hand side of the panel is a palette containing different
categories of user interface components that may be used to construct a user interface, such as
buttons, labels and text fields. It should be noted, however, that not all user interface components are
obviously visible to the user. One such category consists of layouts. Android supports a variety of
layouts that provide different levels of control over how visual user interface components are
positioned and managed on the screen. Though it is difficult to tell from looking at the visual
representation of the user interface, the current design has been created using a ConstraintLayout.
This can be confirmed by reviewing the information in the Component Tree panel which, by default, is
located in the lower left-hand corner of the Layout Editor panel and is shown in Figure 3-11:
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Component Tree 8- I+

i ConstraintLayout
Ab TextView

Figure 3-11

As we can see from the component tree hierarchy, the user interface layout consists of a
ConstraintLayout parent with a single child in the form of a TextView object.

Before proceeding, check that the Layout Editor’s Autoconnect mode is enabled. This means that as
components are added to the layout, the Layout Editor will automatically add constraints to make sure
the components are correctly positioned for different screen sizes and device orientations (a topic that
will be covered in much greater detail in future chapters). The Autoconnect button appears in the
Layout Editor toolbar and is represented by a magnet icon. When disabled the magnet appears with a
diagonal line through it (Figure 3-12). If necessary, re-enable Autoconnect mode by clicking on this
button.

@

P

Figure 3-12

The next step in modifying the application is to delete the TextView component from the design. Begin
by clicking on the TextView object within the user interface view so that it appears with a blue border
around it. Once selected, press the Delete key on the keyboard to remove the object from the layout.

The Palette panel consists of two columns with the left-hand column containing a list of view
component categories. The right-hand column lists the components contained within the currently
selected category. The area immediately beneath the two columns serves as a preview area where a
rendering of the currently selected view type is displayed. In Figure 3-13, for example, the Button view
is currently selected within the Widgets category:
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Palette Q &1+
All Ab TextView
Widgets @ Button |
Text [ A ToggleButton
Layouts CheckBox
Containers ® RadioButton
Images ‘v CheckedTextView
Date = Spinner
Transitions o ProgressBar
Advanced == ProgressBar (Horizontal)
Google -*- SeckBar
Design —#- SeekBar (Discrete)
AppCompat A QuickContactBadge
RatingBar
& Cuwitrh
BUTTOMN
Button
Figure 3-13

Click and drag the Button object (either from the Widgets list, or the preview area) and drop it in the
center of the user interface design when the marker lines appear indicating the center of the display:

BUTTON

< O O

Figure 3-14

The next step is to change the text that is currently displayed by the Button component. The panel
located to the right of the design area is the Properties panel. This panel displays the attributes
assigned to the currently selected component in the layout. Within this panel, locate the text property
and change the current value from “Button” to “Demo” as shown in Figure 3-15:
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Button

style

background wwable/btn_default_mate
backgroundTint

stateListAnirmator ton_state_list_anim_mate
elevation

visibility none n
onClick
TextView -

text ( | Demo _!

et

Figure 3-15
A useful shortcut to changing the text property of a component is to double-click on it in the layout.

This will automatically locate the attribute in the properties panel and select it ready for editing.

The second text property with a wrench next to it allows a text property to be set which only appears
within the Layout Editor tool but is not shown at runtime. This is useful for testing the way in which a
visual component and the layout will behave with different settings without having to run the app
repeatedly.

At this point it is important to explain the red button located in the top right-hand corner of the Layout
Editor tool as indicated in Figure 3-16. Obviously, this is indicating potential problems with the layout.
For details on any problems, click on the button:

Os®HEHE B

(N0} b ]

Figure 3-16

When clicked, a panel (Figure 3-17) will appear describing the nature of the problems and offering
some possible corrective measures:
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Lint Warnings in Layout

Warning: [I18N] Hardcoded string "Demo”, should use "@string” resource

Applies To: lssue Explanation:
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Suggested Fixes:
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Priority: 5 / 10
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Severity: Warning
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£ilma dim dad Sawm anrrea 1 emmmmme

Figure 3-17

Currently, the only warning listed reads as follows:

Warning: [I18N] Hardcoded string “Demo”, should use ‘@string’ resource

This 118N message is informing us that a potential issue exists with regard to the future
internationalization of the project (“I18N” comes from the fact that the word “internationalization”

“« IM

begins with an “I”, ends with an “N” and has 18 letters in between). The warning is reminding us that
when developing Android applications, attributes and values such as text strings should be stored in
the form of resources wherever possible. Doing so enables changes to the appearance of the
application to be made by modifying resource files instead of changing the application source code.
This can be especially valuable when translating a user interface to a different spoken language. If all
of the text in a user interface is contained in a single resource file, for example, that file can be given
to a translator who will then perform the translation work and return the translated file for inclusion
in the application. This enables multiple languages to be targeted without the necessity for any source
code changes to be made. In this instance, we are going to create a new resource named demostring

and assign to it the string “Demo”.

Click on the Extract string resource link in the Issue Explanation panel to display the Extract Resource
panel (Figure 3-18). Within this panel, change the resource name field to demostring and leave the
resource value set to Demo before clicking on the OK button.
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X

#) Extract Resource

Resource name: | demaostring |
Resource value: | Demo
Source set: main

File name: strings.xml
Create the resource in directories:

values -

o IR

Figure 3-18

It is also worth noting that the string could also have been assigned to a resource when it was entered
into the Properties panel. This involves clicking on the button displaying three dots to the right of the
property field in the Properties panel and selecting the Add new resource -> New String Value... menu
option from the resulting Resources dialog. In practice, however, it is often quicker to simply set values
directly into the Properties panel fields for any widgets in the layout, then work sequentially through
the list in the warnings dialog to extract any necessary resources when the layout is complete.

3.5 Reviewing the Layout and Resource Files

Before moving on to the next chapter, we are going to look at some of the internal aspects of user
interface design and resource handling. In the previous section, we made some changes to the user
interface by modifying the content_android_sample.xml file using the Layout Editor tool. In fact, all
that the Layout Editor was doing was providing a user-friendly way to edit the underlying XML content
of the file. In practice, there is no reason why you cannot modify the XML directly in order to make
user interface changes and, in some instances, this may actually be quicker than using the Layout
Editor tool. At the bottom of the Layout Editor panel are two tabs labeled Design and Text respectively.
To switch to the XML view simply select the Text tab as shown in Figure 3-19:
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Figure 3-19

As can be seen from the structure of the XML file, the user interface consists of the ConstraintLayout
component, which in turn, is the parent of the Button object. We can also see that the text property
of the Button is set to our demostring resource. Although varying in complexity and content, all user
interface layouts are structured in this hierarchical, XML based way.

One of the more powerful features of Android Studio can be found to the right-hand side of the XML
editing panel. If the panel is not visible, display it by selecting the Preview button located along the
right-hand edge of the Android Studio window. This is the Preview panel and shows the current visual
state of the layout. As changes are made to the XML layout, these will be reflected in the preview
panel. The layout may also be modified visually from within the Preview panel with the changes
appearing in the XML listing. To see this in action, modify the XML layout to change the background
color of the ConstraintLayout to a shade of red as follows:

<?xml version="1.0" encoding="utf-8"?>
<android.support.constraint.ConstraintLayout
xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:app="http://schemas.android.com/apk/res-auto"
xmlns:tools="http://schemas.android.com/tools"
android:layout width="match parent"
android:layout height="match parent"
app:layout behavior="@string/appbar scrolling view behavior"
tools:context="com.ebookfrenzy.androidsample.AndroidSampleActivity"
tools:showIn="@layout/activity android sample"
android:background="#££2438" >

</android.support.constraint.ConstraintLayout>
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Note that the color of the preview changes in real-time to match the new setting in the XML file. Note
also that a small red square appears in the left-hand margin (also referred to as the gutter) of the XML
editor next to the line containing the color setting. This is a visual cue to the fact that the color red has
been set on a property. Change the color value to #a0ff28 and note that both the small square in the
margin and the preview change to green.

Finally, use the Project view to locate the app -> res -> values -> strings.xml file and double-click on it
to load it into the editor. Currently the XML should read as follows:

<resources>
<string name="app name">AndroidSample</string>
<string name="action settings">Settings</string>
<string name="demostring">Demo</string>
</resources>

As a demonstration of resources in action, change the string value currently assigned to the demostring
resource to “Hello” and then return to the Layout Editor tool by selecting the tab for the layout file in
the editor panel. Note that the layout has picked up the new resource value for the welcome string.

There is also a quick way to access the value of a resource referenced in an XML file. With the Layout
Editor tool in Text mode, click on the “@string/demostring” property setting so that it highlights and
then press Ctrl+B on the keyboard. Android Studio will subsequently open the strings.xml file and take
you to the line in that file where this resource is declared. Use this opportunity to revert the string
resource back to the original “Demo” text.

Resource strings may also be edited using the Android Studio Translations Editor. To open this editor,
right-click on the app -> res -> values -> strings.xml file and select the Open Editor menu option. This
will display the Translation Editor in the main panel of the Android Studio window:

' AndroidSampleActivityjava % | © content_android_samplexml x | & stringsxml % | &) Translations Editor
+ — @ [] Show only keys needing translations 7 Order a translation...

Key Untr Default Value
action_settings Settings

pp_name AndroidSample

Hello

ooo

demostring

Key: | action_settings

Default Value: | Settings

®

£

Translation:
Figure 3-20

This editor allows the strings assigned to resource keys to be edited and for translations for multiple
languages to be managed. The Order a translation... link may also be used to order a translation of the
strings contained within the application to other languages. The cost of the translations will vary
depending on the number of strings involved.
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3.6 Summary

While not excessively complex, a number of steps are involved in setting up an Android development
environment. Having performed those steps, it is worth working through a simple example to make
sure the environment is correctly installed and configured. In this chapter, we have created a simple
application and then used the Android Studio Layout Editor tool to modify the user interface layout.
In doing so, we explored the importance of using resources wherever possible, particularly in the case
of string values, and briefly touched on the topic of layouts. Finally, we looked at the underlying XML
that is used to store the user interface designs of Android applications.

While it is useful to be able to preview a layout from within the Android Studio Layout Editor tool,
there is no substitute for testing an application by compiling and running it. In a later chapter entitled
Creating an Android Virtual Device (AVD) in Android Studio, the steps necessary to set up an emulator
for testing purposes will be covered in detail. Before running the application, however, the next
chapter will take a small detour to provide a guided tour of the Android Studio user interface.
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Chapter 4

4. A Tour of the Android Studio User
Interface

While it is tempting to plunge into running the example application created in the previous
chapter, doing so involves using aspects of the Android Studio user interface which are best
described in advance.

Android Studio is a powerful and feature rich development environment that is, to a large extent,
intuitive to use. That being said, taking the time now to gain familiarity with the layout and
organization of the Android Studio user interface will considerably shorten the learning curve in later
chapters of the book. With this in mind, this chapter will provide an initial overview of the various
areas and components that make up the Android Studio environment.

4.1 The Welcome Screen

The welcome screen (Figure 4-1) is displayed any time that Android Studio is running with no projects
currently open (open projects can be closed at any time by selecting the File -> Close Project menu
option). If Android Studio was previously exited while a project was still open, the tool will by-pass the
welcome screen next time it is launched, automatically opening the previously active project.

| #® weicome to Android Studio = x|
AndroidSample
~\Documents'Books...ORK\AndroidSample
! " f‘.
&=

Android Studio

%% Start a new Android Studio project

[1 Open an existing Android Studio project
¥ Check out project from Version Control =
of Import project (Eclipse ADT, Gradle, etc.)

[ Impert an Android code sample

4 Configure =  Get Help +

Figure 4-1
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In addition to a list of recent projects, the Quick Start menu provides a range of options for performing
tasks such as opening, creating and importing projects along with access to projects currently under
version control. In addition, the Configure menu at the bottom of the window provides access to the
SDK Manager along with a vast array of settings and configuration options. A review of these options
will quickly reveal that there is almost no aspect of Android Studio that cannot be configured and
tailored to your specific needs.

The Configure menu also includes an option to check if updates to Android Studio are available for
download.

4.2 The Main Window

When a new project is created, or an existing one opened, the Android Studio main window will
appear. When multiple projects are open simultaneously, each will be assigned its own main window.
The precise configuration of the window will vary depending on which tools and panels were displayed
the last time the project was open, but will typically resemble that of Figure 4-2.

® AndroidSample - [C:A\Users\Neil\ Doc droid Studie 2.3 - ATWORK, - [app] - .\app\src\main\java\com\ebookfrenzy\androidsam...  — O X
File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
DHO ¢~ %00 QR ¢2 SGap-lb + B GEE &L 2 (5] Q
2 AndroidSample [ app e main  [ijava Flcom [ © i ctivity
& ‘% Android ~ € = | %~ |~ | © AndroidSampleActivityjava * | & content_android_samplexml * | & stringsxml * | & Translations Editor % >
2|7 Clapp I 12
= 1 manifests vie
* Y package com.ebookfrenzy.androidsample;
[ java
A [ com ebookfrenzy.endroidsample | import ...
e @ ' AndroidSampleActivity
= [ com.ebookfrenzy.androidsample (4 1~ ©  public class Activity extends chctivity |
) =1 com ebookfrenzy.androidsample (t —
il protected void onCreate (Bundle savedInstancestate) (
8| < Gradle Seripts 3 super.onCreate (savedInatanceState) ;
=l 2 build.gradle (P setContentView(R.layout.activity android sample);
G & build.gradle (1 Toolbar toolbar = (Ioolbar) findViewById(R.id.toolbar);
® B siadic nspneriopeitics setSupportActionBar(toolbar) ;
B proguard-rules.pro (7 N .
= FloatingActionButton fab = (FloatingActionButton) findViewByld(R.id.fab);
L” gradleproperties fab.setOnClickListener ((view) — [
# settings.gradh Snackbar.make(view, "Replace with your own action", Snackvar.LENGTH LONG)
1l local.properties (5 & .setAction({"Action”, null).show({);
2 i E
@ )
&l public boolean onCreateUptionsMenu{Menu menu) {
£ getMenuInflater () .inflate (R.menu.menn androfid sample, mem);
= return true;
= )
i
& e e
ol pub: oolean onOptionsItemSelected (Memultem item) { #
& o =
£ as ¥ &
A int id [
& |8
P 4Run  SBHTODO W & Android Monitor  [E] Terminal = O Messages e (0 Eventlog (=] Gradle Console
[ Session ‘app': Error Installing APK (2 minutes ago) 11 CRLF: UTF-8¢ i t v 8

Figure 4-2
The various elements of the main window can be summarized as follows:

A - Menu Bar — Contains a range of menus for performing tasks within the Android Studio
environment.

B — Toolbar — A selection of shortcuts to frequently performed actions. The toolbar buttons provide
quicker access to a select group of menu bar actions. The toolbar can be customized by right-clicking
on the bar and selecting the Customize Menus and Toolbars... menu option.
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C — Navigation Bar — The navigation bar provides a convenient way to move around the files and
folders that make up the project. Clicking on an element in the navigation bar will drop down a menu
listing the subfolders and files at that location ready for selection. This provides an alternative to the
Project tool window.

D - Editor Window — The editor window displays the content of the file on which the developer is
currently working. What gets displayed in this location, however, is subject to context. When editing
code, for example, the code editor will appear. When working on a user interface layout file, on the
other hand, the user interface Layout Editor tool will appear. When multiple files are open, each file is
represented by a tab located along the top edge of the editor as shown in Figure 4-3.

@ content_android_samplexml x C AndroidSampleActivity.java

package com.ebookfrenzy.androidsample; v

import ...

< public class AndroidSamplelctivity extends AppCompatictivity |

Figure 4-3

E — Status Bar — The status bar displays informational messages about the project and the activities of
Android Studio together with the tools menu button located in the far left corner. Hovering over items
in the status bar will provide a description of that field. Many fields are interactive, allowing the user
to click to perform tasks or obtain more detailed status information.

F - Project Tool Window — The project tool window provides a hierarchical overview of the project file
structure allowing navigation to specific files and folders to be performed. The toolbar can be used to
display the project in a number of different ways. The default setting is the Android view which is the
mode primarily used in the remainder of this book.

The project tool window is just one of a number of tool windows available within the Android Studio
environment.

4.3 The Tool Windows

In addition to the project view tool window, Android Studio also includes a number of other windows
which, when enabled, are displayed along the bottom and sides of the main window. The tool window
quick access menu can be accessed by hovering the mouse pointer over the button located in the far
left-hand corner of the status bar (Figure 4-4) without clicking the mouse button.
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i+ Android Model
& Android Monitor
1§ Build Variants
@ Captures

1 Event Log

7 Favarites

(& Gradle

[=] Gradle Console
& Messages

® Project

7 Structure
Terminal

i

Executing tasks: [:app:clean,

Figure 4-4

Selecting an item from the quick access menu will cause the corresponding tool window to appear
within the main window.

Alternatively, a set of tool window bars can be displayed by clicking on the quick access menu icon in
the status bar. These bars appear along the left, right and bottom edges of the main window (as
indicated by the arrows in Figure 4-5) and contain buttons for showing and hiding each of the tool
windows. When the tool window bars are displayed, a second click on the button in the status bar will
hide them.

® AndroidSample - [C:\Users\Neil\ Documents\Books\Android Studio 2.3 - AT\WWORK\AndroidSample] - .. — O 2.8

File Edit View MNavigste Code Analyze Refactor Buld Run Tools VCS Window Help

DHO ¢4 XO0 QAR &> A[Eap~|P + 6330 E 3 Al
% ; — 1 e e =

@ 1:Project |y

@ Captures =] T Structure

A Build Variants

[BROIN PloJpUY Sx

P 4Run  HTODO i & Android Monitor  [3 Terminal (= 0: Messages G Event Log Gradle Console
] Session 'app’ Error Installing APK (6 minutes ago) i (e Cantet Snocont=ts) i

Figure 4-5
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Clicking on a button will display the corresponding tool window while a second click will hide the
window. Buttons prefixed with a number (for example 1: Project) indicate that the tool window may
also be displayed by pressing the Alt key on the keyboard (or the Command key for Mac OS X) together
with the corresponding number.

The location of a button in a tool window bar indicates the side of the window against which the
window will appear when displayed. These positions can be changed by clicking and dragging the
buttons to different locations in other window tool bars.

Each tool window has its own toolbar along the top edge. The buttons within these toolbars vary from
one tool to the next, though all tool windows contain a settings option, represented by the cog icon,
which allows various aspects of the window to be changed. Figure 4-6 shows the settings menu for the
project view tool window. Options are available, for example, to undock a window and to allow it to
float outside of the boundaries of the Android Studio main window and to move and resize the tool
panel.

'W' Android M| O = Flatten Packages

e v Compact Empty Middle Packages
manifests

. Show Members
java
Autoscroll to Source
i res
Autoscroll from Source
drawable
layout Sort by Type

@ activity_android_samplexml W i e

& content_android_samplexml V' Pinned Mode

menu v Docked Mode
mipmap Floating Mode
values Windowed Mode
& Gradle Scripts Split Mode
Remove from Sidebar
v Group Tabs
Move to 4
Resize »
Figure 4-6

All of the windows also include a far right button on the toolbar providing an additional way to hide
the tool window from view. A search of the items within a tool window can be performed simply by
giving that window focus by clicking in it and then typing the search term (for example the name of a
file in the Project tool window). A search box will appear in the window’s tool bar and items matching
the search highlighted.

Android Studio offers a wide range of window tool windows, the most commonly used of which are as
follows:

Project — The project view provides an overview of the file structure that makes up the project allowing
for quick navigation between files. Generally, double-clicking on a file in the project view will cause
that file to be loaded into the appropriate editing tool.
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Structure — The structure tool provides a high level view of the structure of the source file currently
displayed in the editor. This information includes a list of items such as classes, methods and variables
in the file. Selecting an item from the structure list will take you to that location in the source file in
the editor window.

Captures — The captures tool window provides access to performance data files that have been
generated by the monitoring tools contained within the Android Monitor tool window.

Favorites — A variety of project items can be added to the favorites list. Right-clicking on a file in the
project view, for example, provides access to an Add to Favorites menu option. Similarly, a method in
a source file can be added as a favorite by right-clicking on it in the Structure tool window. Anything
added to a Favorites list can be accessed through this Favorites tool window.

Build Variants — The build variants tool window provides a quick way to configure different build
targets for the current application project (for example different builds for debugging and release
versions of the application, or multiple builds to target different device categories).

TODO — As the name suggests, this tool provides a place to review items that have yet to be completed
on the project. Android Studio compiles this list by scanning the source files that make up the project
to look for comments that match specified TODO patterns. These patterns can be reviewed and
changed by selecting the File -> Settings... menu option and navigating to the TODO page listed under
Editor.

Messages — The messages tool window records output from the Gradle build system (Gradle is the
underlying system used by Android Studio for building the various parts of projects into runnable
applications) and can be useful for identifying the causes of build problems when compiling application
projects.

Android Monitor — The Android Monitor tool window provides access to the Android debugging
system. Within this window tasks such as monitoring log output from a running application, taking
screenshots and videos of the application, stopping a process and performing basic debugging tasks
can be performed. The tool also includes real-time GPU, networking, memory and CPU usage monitors.

Android Model — The Android Model tool window provides a single location in which to view an
exhaustive list of the different options and settings configured within the project. These can range
from the more obvious settings such as the target Android SDK version to more obscure values such
as build configuration rules.

Terminal — Provides access to a terminal window on the system on which Android Studio is running.
On Windows systems this is the Command Prompt interface, while on Linux and Mac OS X systems this
takes the form of a Terminal prompt.

Run — The run tool window becomes available when an application is currently running and provides
a view of the results of the run together with options to stop or restart a running process. If an
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application is failing to install and run on a device or emulator, this window will typically provide
diagnostic information relating to the problem.

Event Log — The event log window displays messages relating to events and activities performed within
Android Studio. The successful build of a project, for example, or the fact that an application is now
running will be reported within this tool window.

Gradle Console — The Gradle console is used to display all output from the Gradle system as projects
are built from within Android Studio. This will include information about the success or otherwise of
the build process together with details of any errors or warnings.

Gradle — The Gradle tool window provides a view onto the Gradle tasks that make up the project build
configuration. The window lists the tasks that are involved in compiling the various elements of the
project into an executable application. Right-click on a top level Gradle task and select the Open Gradle
Config menu option to load the Gradle build file for the current project into the editor. Gradle will be
covered in greater detail later in this book.

4.4 Android Studio Keyboard Shortcuts

Android Studio includes an abundance of keyboard shortcuts designed to save time when performing
common tasks. A full keyboard shortcut keymap listing can be viewed and printed from within the
Android Studio project window by selecting the Help -> Keymap Reference menu option.

4.5 Switcher and Recent Files Navigation

Another useful mechanism for navigating within the Android Studio main window involves the use of
the Switcher. Accessed via the Ctrl-Tab keyboard shortcut, the switcher appears as a panel listing both
the tool windows and currently open files (Figure 4-7).

Switcher

® 1: Project C AndreidSamplelctivity java
71 2 Favorites ") Translations Editor

‘% 3 Android Model @ content_android_samplexml
P 4 Run © AndroidSampleActivity java
" 3 Build Variants S AndroidSamplectivity java
% & Android Monitor = content_android_samplexml

v T: Structure
® g Captures
4: Event Log
& A Gradle
[=l B: Gradle Console
[E C: Terminal
=0 D: TODO

_\Android I WORK) I Aapphsrcimaintres)

Figure 4-7

Once displayed, the switcher will remain visible for as long as the Ctrl key remains depressed.
Repeatedly tapping the Tab key while holding down the Ctrl key will cycle through the various selection

39



A Tour of the Android Studio User Interface

options, while releasing the Ctrl key causes the currently highlighted item to be selected and displayed

within the main window.

In addition to the switcher, navigation to recently opened files is provided by the Recent Files panel
(Figure 4-8). This can be accessed using the Ctrl-E keyboard shortcut (Cmd-E on Mac OS X). Once
displayed, either the mouse pointer can be used to select an option or, alternatively, the keyboard
arrow keys can be used to scroll through the file name and tool window options. Pressing the Enter

key will select the currently highlighted item.

Recent Files

= "
= Messages £ content_android_samplexml

% Project £ AndroidSamplefctivity.java

¢ Favorites 3 Translations Editor
& Android Model
P Run
% Build Variants
& Android Menitor
7 Structure
o Captures

Event Log
& Gradle
[E Gradle Conscle
= Terminal
8 TODO

—\A i L WORIKA i \applsrc\mainires\l

Figure 4-8

4.6 Changing the Android Studio Theme

The overall theme of the Android Studio environment may be changed either from the welcome screen
using the Configure -> Settings option, or via the File -> Settings... menu option of the main window.

Once the settings dialog is displayed, select the Appearance option in the left-hand panel and then
change the setting of the Theme menu before clicking on the Apply button. The themes currently
available consist of IntelliJ, Windows and Darcula. Figure 4-9 shows an example of the main window

with the Darcula theme selected:

40



A Tour of the Android Studio User Interface

)

- [CAUsers\eil\ Doc droid Studio 2.3 - ATUWORK\ - [appl - Aapphsrc f\content_android_sampleami - Android Studio 23Bet.. — O X

Figure 4-9
4.7 Summary

The primary elements of the Android Studio environment consist of the welcome screen and main
window. Each open project is assigned its own main window which, in turn, consists of a menu bar,
toolbar, editing and design area, status bar and a collection of tool windows. Tool windows appear on
the sides and bottom edges of the main window and can be accessed either using the quick access
menu located in the status bar, or via the optional tool window bars.

There are very few actions within Android Studio which cannot be triggered via a keyboard shortcut.
A keymap of default keyboard shortcuts can be accessed at any time from within the Android Studio
main window.
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Chapter 5

5. Creating an Android Virtual Device
(AVD) in Android Studio

n the course of developing Android apps in Android Studio it will be necessary to compile and run
Ian application multiple times. An Android application may be tested by installing and running it
either on a physical device or in an Android Virtual Device (AVD) emulator environment. Before an AVD
can be used, it must first be created and configured to match the specification of a particular device
model. The goal of this chapter, therefore, is to work through the steps involved in creating such a
virtual device using the Nexus 9 tablet as a reference example.

5.1 About Android Virtual Devices

AVDs are essentially emulators that allow Android applications to be tested without the necessity to
install the application on a physical Android based device. An AVD may be configured to emulate a
variety of hardware features including options such as screen size, memory capacity and the presence
or otherwise of features such as a camera, GPS navigation support or an accelerometer. As part of the
standard Android Studio installation, a number of emulator templates are installed allowing AVDs to
be configured for a range of different devices. Additional templates may be loaded or custom
configurations created to match any physical Android device by specifying properties such as processor
type, memory capacity and the size and pixel density of the screen. Check the online developer
documentation for your device to find out if emulator definitions are available for download and
installation into the AVD environment.

When launched, an AVD will appear as a window containing an emulated Android device environment.
Figure 5-1, for example, shows an AVD session configured to emulate the Google Nexus 9 model.

New AVDs are created and managed using the Android Virtual Device Manager, which may be used
either in command-line mode or with a more user-friendly graphical user interface.
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Figure 5-1
5.2 Creating a New AVD

In order to test the behavior of an application in the absence of a physical device, it will be necessary
to create an AVD for a specific Android device configuration.

To create a new AVD, the first step is to launch the AVD Manager. This can be achieved from within
the Android Studio environment by selecting the Tools -> Android -> AVD Manager menu option from
within the main window. Alternatively, the tool may be launched from a terminal or command-line
prompt using the following command:

android avd

Once launched, the tool will appear as outlined in Figure 5-2. Assuming a new Android Studio
installation, only a Nexus 5 AVD will currently be listed:

® Android Virtual Device Manager - [m] X

&

Your Virtual Devices
M] Android Studio

Type Name Resolution APL Target CPU/ABI Size on Disk Actions

E Nexus 5API23x86 1080 x 1920: xxh. 23 Google APIs x86 750 MB | a4
+ Create Virtual Devic.. | 53
Figure 5-2
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To add an additional AVD, begin by clicking on the Create Virtual Device button in order to invoke the

Virtual Device Configuration dialog:

® Virtual Device Configuration 'S

Q~
& ) [] Nexus5
Categor Name~ | size | Resoltion | Density
w Nexus § 20° 430,300 hdpi
Tablet Nexus One 37 430x800 hdpi O
Size normal

Wear Nexus 60 57 144062560 560dpi S:tnlgm« ')'Q“(ﬂz:‘g
W Nexus 6 596" 14402560 S60dpi 25 Jeonom

Nexus 55 5. 1080x1920 420dpi

2"
47"

768x1280 xhdpi

Nexus 4
Galaxy Nexus 465" 720x1280 xhdpi

SAPWVGA  54° 430854 mdpi
New Hardware Profile | | Import Hardware Profiles

(2

| Clone bevice... |

[ ) I (ma) [

Figure 5-3

Within the dialog, perform the following steps to create a Nexus 9 compatible emulator:

1.

5.

From the Category panel, select the Tablet option to display the list of available Android tablet
AVD templates.

Select the Nexus 9 device option and click Next.

On the System Image screen, select the latest version of Android (at time of writing this is
Nougat, APl level 25, Android 7.1.1 with Google APIs) for the x86_64 ABI. Note that if the system
image has not yet been installed a Download link will be provided next to the Release Name.
Click this link to download and install the system image before selecting it. If the image you need
is not listed, click on the x86 images and Other images tabs to view alternative lists.

Click Next to proceed and enter a descriptive name (for example Nexus 9 AP/ 25) into the name
field or simply accept the default name.

Click Finish to create the AVD.

With the AVD created, the AVD Manager may now be closed. If future modifications to the AVD are
necessary, simply re-open the AVD Manager, select the AVD from the list and click on the pencil icon

in the Actions column of the device row in the AVD Manager.

5.3 Starting the Emulator

To perform a test run of the newly created AVD emulator, simply select the emulator from the AVD
Manager and click on the launch button (the green triangle in the Actions column). The emulator will

appear in a new window and, after a short period of time, the “android” logo will appear in the center
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of the screen. The amount of time it takes for the emulator to start will depend on the configuration
of both the AVD and the system on which it is running. In the event that the startup time on your
system is considerable, do not hesitate to leave the emulator running. The system will detect that it is
already running and attach to it when applications are launched, thereby saving considerable amounts
of startup time.

The emulator probably defaulted to appearing in landscape orientation. It is useful to be aware that
this and other default options can be changed. Within the AVD Manager, select the new Nexus 9 entry
and click on the pencil icon in the Actions column of the device row. In the configuration screen locate
the Startup and orientation section and change the orientation setting. Exit and restart the emulator
session to see this change take effect. More details on the emulator are covered in the next chapter
(Using and Configuring the Android Studio AVD Emulator).

To save time in the next section of this chapter, leave the emulator running before proceeding.

5.4 Running the Application in the AVD

With an AVD emulator configured, the example AndroidSample application created in the earlier
chapter now can be compiled and run. With the AndroidSample project loaded into Android Studio,
simply click on the run button represented by a green triangle located in the Android Studio toolbar
as shown in Figure 5-4 below, select the Run -> Run... menu option or use the Shift+F10 keyboard
shortcut:

Run Tools YC5 Window |

Ceapp~| v & %

layo! Run 'app’ (Shift+F10) 1 san

Figure 5-4

By default, Android Studio will respond to the run request by displaying the Select Deployment Target
dialog. This provides the option to execute the application on an AVD instance that is already running,
or to launch a new AVD session specifically for this application. Figure 5-5 lists the previously created
Nexus 9 AVD as a running device as a result of the steps performed in the preceding section. With this
device selected in the dialog, click on OK to install and run the application on the emulator.
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) Select Deployrnent Target ot

Connected Devices

Mexus 9 APl 25 (Android 7.1, API 23)

Available Virtual Devices

[ Nexus 5% API 2586

| Create New Virtual Device Don't see your device?
D Use same selection for future launches m | Cancel |
Figure 5-5

Once the application is installed and running, the user interface for the AndroidSampleActivity class

will appear within the emulator:
[} 4l W 251

AndroidSample

@

q o) o
Figure 5-6

In the event that the activity does not automatically launch, check to see if the launch icon has
appeared among the apps on the emulator. If it has, simply click on it to launch the application. Once
the run process begins, the Run and Android Monitor tool windows will become available. The Run
tool window will display diagnostic information as the application package is installed and launched.
Figure 5-7 shows the Run tool window output from a successful application launch:

47



Creating an Android Virtual Device (AVD) in Android Studio

PPON PIOIPUY 4

bookrrenzy,
cegory. LADNCEER] cmp=co

# 2 Favorites 3

BiRinl 2000 i G AndcoiMonter G Messages I
[5] Gradie buid finished in 155 146ms (5 minutes ago)

Figure 5-7
If problems are encountered during the launch process, the Run tool will provide information that will
hopefully help to isolate the cause of the problem.

Assuming that the application loads into the emulator and runs as expected, we have safely verified
that the Android development environment is correctly installed and configured.

5.5 Run/Debug Configurations

A particular project can be configured such that a specific device or emulator is used automatically
each time it is run from within Android Studio. This avoids the necessity to make a selection from the
device chooser each time the application is executed. To review and modify the Run/Debug
configuration, click on the button to the left of the run button in the Android Studio toolbar and select
the Edit Configurations... option from the resulting menu:

D> N([Eapp=/P + & 5 N

SN =] - Edit Configurations.., lnpte.xml

Ancir::uidﬁa [ app ent_andro
tte Q= 1rEHEA ©

Figure 5-8

In the Run/Debug Configurations dialog, the application may be configured to always use a preferred
emulator by selecting Emulator from the Target menu located in the Deployment Target Options
section and selecting the emulator from the drop down menu. Figure 5-9, for example, shows the
AndroidSample application configured to run by default on the previously created Nexus 9 emulator:
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Figure 5-9
Be sure to switch the Target menu setting back to "Show Device Chooser Dialog" mode before moving
on to the next chapter of the book.
5.6 Stopping a Running Application
To stop a running application, simply click on stop button located in the main toolbar as shown in
Figure 5-10:
.+ b G| R &
wntent_android, Stop ‘app’ (Ctri+F2)
Figure 5-10

An app may also be terminated using the Android Monitor. Begin by displaying the Android Monitor
tool window either using the window bar button, or via the quick access menu (invoked by moving the
mouse pointer over the button in the left-hand corner of the status bar as shown in Figure 5-11).
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Once the Android tool window appears, select the androidsample app menu highlighted in Figure 5-12
below:

Android Monitor R L

| 5 Emulator Nexws_9_APL 24 Android 1, 471 24 @ommaummmle 4519) j
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07-16 14:51:19.959 4619-4619/com.ebockfirenzy.androidsample W/art: Class android.suppert.v4.content.ContextCompat failed lock verification and will run slower
[x] 07-16 14:51:19.980 4619-4619/com.ebockfrenzy.androidsample W/art: Class android.support.v4.util.SimpleArrayMap failed lock verification and will run slower.
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» | o
P.2Run 2 TODO | & & Android Monitor | 0: Messages  [E] Terminal Eventlog (5] Gradle Console

Figure 5-12
With the process selected, stop it by clicking on the red Terminate Application button in the vertical

toolbar to the left of the process list indicated by the arrow in the above figure.

An alternative to using the Android tool window is to open the Android Device Monitor. This can be
launched via the Tools -> Android -> Android Device Monitor menu option. Once launched, the process
may be selected from the list (Figure 5-13) and terminated by clicking on the red Stop button located
in the toolbar above the list.
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Figure 5-13

5.7 AVD Command-line Creation

As previously discussed, in addition to the graphical user interface it is also possible to create a new
AVD directly from the command-line. This is achieved using the android tool in conjunction with some

command-line options. Once initiated,
the new AVD.

the tool will prompt for additional information before creating

Assuming that the system has been configured such that the Android SDK tools directory is included
in the PATH environment variable, a list of available targets for the new AVD may be obtained by

issuing the following command in a terminal or command window:

android list targets

The resulting output from the above command will contain a list of Android SDK versions that are

available on the system. For example:

Available Android targets:

id: 1 or "Google Inc.:Google APIs:23"

Name: Google APIs
Type: Add-On
Vendor: Google Inc.
Revision: 1

Description: Android + Google APIs

Based on Android 6.0

(API level 23)
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Libraries:
* com.google.android.media.effects (effects.jar)
Collection of video effects
* com.android. future.usb.accessory (usb.jar)
API for USB Accessories
* com.google.android.maps (maps.jar)
API for Google Maps
Skins: HVGA, QVGA, WQVGA400, WQVGA432, WSVGA, WVGAB800 (default),
WVGA854, WXGA720, WXGA800, WXGA800-7in
Tag/ABIs : google apis/x86
id: 2 or "android-25"
Name: Android 7.1.1
Type: Platform
API level: 25
Revision: 3
Skins: HVGA, QVGA, WQVGA400, WQVGA432, WSVGA, WVGA800 (default),
WVGA854, WXGA720, WXGA800, WXGA800-7in
Tag/ABIs : no ABIs.

The syntax for AVD creation is as follows:

android create avd -n <name> -t <targetID> [-<option> <value>]

For example, to create a new AVD named Nexus9 using the target ID for the Android API level 25 device
(in this case ID 2) using the default x86_64 ABI, the following command may be used:

android create avd -n Nexus9 -t 2 --abi "default/x86 64"

The android tool will create the new AVD to the specifications required for a basic Android 7 device,
also providing the option to create a custom configuration to match the specification of a specific
device if required. Once a new AVD has been created from the command line, it may not show up in
the Android Device Manager tool until the Refresh button is clicked.

In addition to the creation of new AVDs, a number of other tasks may be performed from the command
line. For example, a list of currently available AVDs may be obtained using the list avd command line
arguments:

android list avd

Available Android Virtual Devices:
Name: Nexus9
Path: C:\Users\Neil\.android\avd\demotest.avd
Target: Android 7.1 (API level 25)
Tag/ABI: default/x86 64
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Skin: WVGA800

Name: Nexus 9 API 25
Device: Nexus 9 (Google)
Path: C:\Users\Neil\.android\avd\Nexus 9 API 25.avd
Target: Android 7.1 (API level 25)
Tag/ABI: default/x86 64
Skin: nexus 9
Sdcard: 100M

Similarly, to delete an existing AVD, simply use the delete option as follows:

android delete avd —-n <avd name>

5.8 Android Virtual Device Configuration Files

By default, the files associated with an AVD are stored in the .android/avd sub-directory of the user’s
home directory, the structure of which is as follows (where <avd name> is replaced by the name
assigned to the AVD):

<avd name>.avd/config.ini
<avd name>.avd/userdata.img
<avd name>.ini

The config.ini file contains the device configuration settings such as display dimensions and memory
specified during the AVD creation process. These settings may be changed directly within the
configuration file and will be adopted by the AVD when it is next invoked.

The <avd name>.ini file contains a reference to the target Android SDK and the path to the AVD files.
Note that a change to the image.sysdir value in the config.ini file will also need to be reflected in the
target value of this file.

5.9 Moving and Renaming an Android Virtual Device

The current name or the location of the AVD files may be altered from the command line using the
android tool’s move avd argument. For example, to rename an AVD named Nexus9 to Nexus9B, the
following command may be executed:

android move avd -n Nexus9 -r Nexus9B

To physically relocate the files associated with the AVD, the following command syntax should be used:
android move avd -n <avd name> -p <path to new location>

For example, to move an AVD from its current file system location to /tmp/Nexus9Test:

android move avd -n Nexus9 -p /tmp/Nexus9Test
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Note that the destination directory must not already exist prior to executing the command to move
an AVD.

5.10 Summary

A typical application development process follows a cycle of coding, compiling and running in a test
environment. Android applications may be tested on either a physical Android device or using an
Android Virtual Device (AVD) emulator. AVDs are created and managed using the Android AVD
Manager tool which may be used either as a command line tool or using a graphical user interface.
When creating an AVD to simulate a specific Android device model it is important that the virtual
device be configured with a hardware specification that matches that of the physical device.
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Chapter 6

6. Using and Configuring the Android
Studio AVD Emulator

The Android Virtual Device (AVD) emulator environment bundled with Android Studio 1.x was an
uncharacteristically weak point in an otherwise reputable application development environment.
Regarded by many developers as slow, inflexible and unreliable, the emulator was long overdue for an
overhaul. Fortunately, Android Studio 2 introduced an enhanced emulator environment providing
significant improvements in terms of configuration flexibility and overall performance. According to
the Android Studio team at Google, launching an app on the new emulator is now faster than running
on a physical Android device. Not only does the emulator contain many new configuration options,
these changes can be made in real-time while the application is running.

Before the next chapter explores testing on physical Android devices, this chapter will take some time
to provide an overview of the Android Studio AVD emulator and highlight many of the configuration
features that are available to customize the environment.

6.1 The Emulator Environment

When launched, the emulator displays an initial splash screen during the loading process as illustrated
in Figure 6-1:

Android Emulater

1

Figure 6-1

Once loaded, the main emulator window appears containing a representation of the chosen device
type (in the case of Figure 6-2 this is a Nexus 5X device):
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Figure 6-2

Positioned along the right-hand edge of the window is the toolbar providing quick access to the

emulator controls and configuration options.

6.2 The Emulator Toolbar Options

The emulator toolbar (Figure 6-3) provides access to a range of options relating to the appearance and

behavior of the emulator environment.
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Figure 6-3

Each button in the toolbar has associated with it a keyboard accelerator which can be identified either

by hovering the mouse pointer over the button and waiting for the tooltip to appear, or via the help

option of the extended controls panel.

Though many of the options contained within the toolbar are self-explanatory, each option will be

covered for the sake of completeness:

Exit / Minimize — The uppermost ‘x’ button in the toolbar exits the emulator session when selected
while the ‘-* option minimizes the entire window.

Power — The Power button simulates the hardware power button on a physical Android device.
Clicking and releasing this button will lock the device and turn off the screen. Clicking and holding
this button will initiate the device “Power off” request sequence.

Volume Up / Down — Two buttons that control the audio volume of playback within the simulator
environment.

Rotate Left/Right — Rotates the emulated device between portrait and landscape orientations.
Screenshot — Takes a screenshot of the content currently displayed on the device screen. The
captured image is stored at the location specified in the Settings screen of the extended controls
panel as outlined later in this chapter.

Zoom Mode — This button toggles in and out of zoom mode, details of which will be covered later
in this chapter.
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o Back —Simulates selection of the standard Android “Back” button. As with the Home and Overview
buttons outlined below, the same results can be achieved by selecting the actual buttons on the
emulator screen.

o Home — Simulates selection of the standard Android “Home” button.

e Overview — Simulates selection of the standard Android “Overview” button which displays the
currently running apps on the device.

e Extended Controls — Displays the extended controls panel, allowing for the configuration of
options such as simulated location and telephony activity, battery strength, cellular network type
and fingerprint identification.

6.3 Working in Zoom Mode

The zoom button located in the emulator toolbar switches in and out of zoom mode. When zoom
mode is active the toolbar button is depressed and the mouse pointer appears as a magnifying glass
when hovering over the device screen. Clicking the left mouse button will cause the display to zoom
in relative to the selected point on the screen, with repeated clicking increasing the zoom level.
Conversely, clicking the right mouse button decreases the zoom level. Toggling the zoom button off
reverts the display to the default size.

Clicking and dragging while in zoom mode will define a rectangular area into which the view will zoom
when the mouse button is released.

While in zoom mode the visible area of the screen may be panned using the horizontal and vertical
scrollbars located within the emulator window.

6.4 Resizing the Emulator Window

The size of the emulator window (and the corresponding representation of the device) can be changed
at any time by clicking and dragging on any of the corners or sides of the window.

6.5 Extended Control Options

The extended controls toolbar button displays the panel illustrated in Figure 6-4. By default, the
location settings will be displayed. Selecting a different category from the left-hand panel will display
the corresponding group of controls:
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Extended controls

- Decimal Longitude
“ -78.8717
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Figure 6-4

6.5.1 Location

The location controls allow simulated location information to be sent to the emulator in the form of
decimal or sexigesimal coordinates. Location information can take the form of a single location, or a
sequence of points representing movement of the device, the latter being provided via a file in either
GPS Exchange (GPX) or Keyhole Markup Language (KML) format.

A single location is transmitted to the emulator when the Send button is clicked. The transmission of
GPS data points begins once the “play” button located beneath the data table is selected. The speed
at which the GPS data points are fed to the emulator can be controlled using the speed menu adjacent
to the play button.

6.5.2 Cellular

The type of cellular connection being simulated can be changed within the cellular settings screen.
Options are available to simulate different network types (CSM, EDGE, HSDPA etc) in addition to a
range of voice and data scenarios such as roaming and denied access.

6.5.3 Battery

A variety of simulated battery state and charging conditions can be simulated on this panel of the
extended controls screen, including battery charge level, battery health and whether the AC charger
is currently connected.

6.5.4 Phone

The phone extended controls provide two very simple but useful simulations within the emulator. The
first option allows for the simulation of an incoming call from a designated phone number. This can be
of particular use when testing the way in which an app handles high level interrupts of this nature.
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The second option allows the receipt of text messages to be simulated within the emulator session. As
inthe real world, these messages appear within the Message app and trigger the standard notifications
within the emulator.

6.5.5 Directional Pad

A directional pad (D-Pad) is an additional set of controls either built into an Android device or
connected externally (such as a game controller) that provides directional controls (left, right, up,
down). The directional pad settings allow D-Pad interaction to be simulated within the emulator.

6.5.6 Fingerprint

Many Android devices are now supplied with built-in fingerprint detection hardware. The AVD
emulator makes it possible to test fingerprint authentication without the need to test apps on a
physical device containing a fingerprint sensor. Details on how to configure fingerprint testing within
the emulator will be covered in detail later in this chapter.

6.5.7 Virtual Sensors

The virtual sensors option allows the accelerometer and magnetometer to be simulated to emulate
the effects of the physical motion of a device such as rotation, movement and tilting through yaw,
pitch and roll settings.

6.5.8 Settings

The settings panel provides a small group of configuration options. Use this panel to choose a darker
theme for the toolbar and extended controls panel, specify a file system location into which
screenshots are to be saved, and to configure the emulator window to appear on top of other windows
on the desktop.

6.5.9 Help

The Help screen contains three sub-panels containing a list of keyboard shortcuts, links to access the
emulator online documentation, file bugs and send feedback, and emulator version information.

6.6 Drag and Drop Support

An Android application is packaged into an APK file when it is built. When Android Studio built and ran
the AndroidSample app created earlier in this book, for example, the application was compiled and
packaged into an APK file. That APK file was then transferred to the emulator and launched.

The Android Studio emulator also supports installation of apps by dragging and dropping the
corresponding APK file onto the emulator window. To experience this in action, start the emulator,
open Settings and select the Apps option. Within the list of installed apps, locate and select the
AndroidSample app and, in the app detail screen, uninstall the app from the emulator.
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Open the file system navigation tool for your operating system (e.g. Windows Explorer for Windows
or Finder for Mac OS X) and navigate to the folder containing the AndroidSample project. Within this
folder locate the app/build/outputs/apk subfolder. This folder should contain two APK files named
app-debug.apk and app-debug-unaligned.apk. Drag the app-debug.apk file and drop it onto the
emulator window. The dialog shown in (Figure 6-5) will subsequently appear as the APK file is installed.

7 APK Installer ? >

Installing APK. ..

|

Figure 6-5
Once the APK file installation has completed, locate the app on the device and click on it to launch it.

In addition to APK files, any other type of file such as image, video or data files can be installed onto
the emulator using this drag and drop feature. Such files are added to the SD card storage area of the
emulator where they may subsequently be accessed from within app code.

6.7 Configuring Fingerprint Emulation

The emulator allows up to 10 simulated fingerprints to be configured and used to test fingerprint
authentication within Android apps. To configure simulated fingerprints begin by launching the
emulator, opening the Settings app and selecting the Security option.

Within the Security settings screen, select the Use fingerprint option. On the resulting information
screen click on the Next button to proceed to the Fingerprint setup screen. Before fingerprint security
can be enabled a backup screen unlocking method (such as a PIN number) must be configured. Click
on the Fingerprint + PIN button, enter and confirm a suitable PIN number and complete the PIN entry
process.

Proceed through the remaining screens until the Settings app requests a fingerprint on the sensor. At
this point display the extended controls dialog, select the Fingerprint category in the left-hand panel
and make sure that Finger 1 is selected in the main settings panel:
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Q Fingerprint

Finger 1

TOUCH SENSOR

Figure 6-6

Click on the Touch Sensor button to simulate Finger 1 touching the fingerprint sensor. The emulator
will report the successful addition of the fingerprint:

] %l 257

Fingerprint added!

Whenever you see this icon, you can use your
fingerprint for identification or to authorize a
purchase,

Figure 6-7

To add additional fingerprints click on the Add Another button and select another finger from the
extended controls panel menu before clicking on the Touch Sensor button once again. The topic of
building fingerprint authentication into an Android app is covered in detail in the chapter entitled An
Android Fingerprint Authentication Tutorial.

6.8 Summary

Android Studio 2 contains a new and improved Android Virtual Device emulator environment designed
to make it easier to test applications without the need to run on a physical Android device. This chapter
has provided a brief tour of the emulator and highlighted key features that are available to configure
and customize the environment to simulate different testing conditions.

62



Chapter 7

7. Testing Android Studio Apps on a
Physical Android Device

Whilst much can be achieved by testing applications using an Android Virtual Device (AVD), there
is no substitute for performing real world application testing on a physical Android device and
there are a number of Android features that are only available on physical Android devices.

Communication with both AVD instances and connected Android devices is handled by the Android
Debug Bridge (ADB). In this chapter we will work through the steps to configure the adb environment
to enable application testing on a physical Android device with Mac OS X, Windows and Linux based
systems.

7.1 An Overview of the Android Debug Bridge (ADB)

The primary purpose of the ADB is to facilitate interaction between a development system, in this case
Android Studio, and both AVD emulators and physical Android devices for the purposes of running and
debugging applications.

The ADB consists of a client, a server process running in the background on the development system
and a daemon background process running in either AVDs or real Android devices such as phones and
tablets.

The ADB client can take a variety of forms. For example, a client is provided in the form of a command-
line tool named adb located in the Android SDK platform-tools sub-directory. Similarly, Android Studio
also has a built-in client.

A variety of tasks may be performed using the adb command-line tool. For example, a listing of
currently active virtual or physical devices may be obtained using the devices command-line argument.
The following command output indicates the presence of an AVD on the system but no physical
devices:

$ adb devices
List of devices attached
emulator-5554 device
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7.2 Enabling ADB on Android based Devices

Before ADB can connect to an Android device, that device must first be configured to allow the
connection. On phone and tablet devices running Android 6.0 or later, the steps to achieve this are as
follows:

1. Open the Settings app on the device and select the About tablet or About phone option.
2. Onthe About screen, scroll down to the Build number field (Figure 7-1) and tap on it seven times
until a message appears indicating that developer mode has been enabled.

Kernel version

3.10.103-ge912bb7
android-build@wped26.hot.corp.google.com #1
Fri Oct 21 17:15:52 UTC 2016

Build number
N4F26M

Figure 7-1

3. Return to the main Settings screen and note the appearance of a new option titled Developer
options. Select this option and locate the setting on the developer screen entitled USB debugging.
Enable the switch next to this item as illustrated in Figure 7-2:

Debugging

USB debugging .

Debug mode when USB is connected

Figure 7-2

4. Swipe downward from the top of the screen to display the notifications panel (Figure 7-3) and
note that the device is currently connected for debugging.

USB debugging connected
Touch to disable USB debugging.

Figure 7-3

At this point, the device is now configured to accept debugging connections from adb on the
development system. All that remains is to configure the development system to detect the device
when it is attached. While this is a relatively straightforward process, the steps involved differ
depending on whether the development system is running Windows, Mac OS X or Linux. Note that the
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following steps assume that the Android SDK platform-tools directory is included in the operating
system PATH environment variable as described in the chapter entitled Setting up an Android Studio
Development Environment.

7.2.1 Mac OS X ADB Configuration

In order to configure the ADB environment on a Mac OS X system, connect the device to the computer
system using a USB cable, open a terminal window and execute the following command:

android update adb
Next, restart the adb server by issuing the following commands in the terminal window:

$ adb kill-server

$ adb start-server

* daemon not running. starting it now on port 5037 *
* daemon started successfully *

Once the server is successfully running, execute the following command to verify that the device has
been detected:

$ adb devices
List of devices attached
74CE000600000001 offline

If the device is listed as offline, go to the Android device and check for the presence of the dialog shown
in Figure 7-4 seeking permission to Allow USB debugging. Enable the checkbox next to the option that
reads Always allow from this computer, before clicking on OK. Repeating the adb devices command
should now list the device as being available:

List of devices attached
015d41d4454bf80c device

In the event that the device is not listed, try logging out and then back in to the Mac OS X desktop and,
if the problem persists, rebooting the system.

7.2.2 Windows ADB Configuration

The first step in configuring a Windows based development system to connect to an Android device
using ADB is to install the appropriate USB drivers on the system. The USB drivers to install will depend
on the model of Android Device. If you have a Google Nexus device, then it will be necessary to install
and configure the Google USB Driver package on your Windows system. Detailed steps to achieve this
are outlined on the following web page:

http://developer.android.com/sdk/win-usb.html|
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For Android devices not supported by the Google USB driver, it will be necessary to download the
drivers provided by the device manufacturer. A listing of drivers together with download and
installation information can be obtained online at:

http://developer.android.com/tools/extras/oem-usb.html

With the drivers installed and the device now being recognized as the correct device type, open a
Command Prompt window and execute the following command:

adb devices
This command should output information about the connected device similar to the following:

List of devices attached
HT4CTJT01906 offline

If the device is listed as offline or unauthorized, go to the device display and check for the dialog shown
in Figure 7-4 seeking permission to Allow USB debugging.

Allow USB debugging?
The computer's RSA key fingerprint is:

6E:BF:56:13:95:F8:9B:7E:12:CF:C5:67
|:| Always allow from this computer

CANCEL OK

Figure 7-4

Enable the checkbox next to the option that reads Always allow from this computer, before clicking on
OK. Repeating the adb devices command should now list the device as being ready:

List of devices attached
HT4CTJT01906 device

In the event that the device is not listed, execute the following commands to restart the ADB server:

adb kill-server
adb start-server

If the device is still not listed, try executing the following command:

android update adb

Note that it may also be necessary to reboot the system.
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7.2.3 Linux adb Configuration

For the purposes of this chapter, we will once again use Ubuntu Linux as a reference example in terms
of configuring adb on Linux to connect to a physical Android device for application testing.

Begin by attaching the Android device to a USB port on the Ubuntu Linux system. Once connected,
open a Terminal window and execute the Linux Isusb command to list currently available USB devices:

~$ 1lsusb
Bus 001 Device 003: ID 18dl:4e44 asus Nexus 7 [9999]
Bus 001 Device 001: ID 1d6b:0001 Linux Foundation 1.1 root hub

Each USB device detected on the system will be listed along with a vendor ID and product ID. A list of
vendor IDs can be found online at http://developer.android.com/tools/device.html#Vendorlds. The
above output shows that a Google Nexus 7 device has been detected. Make a note of the vendor and
product ID numbers displayed for your particular device (in the above case these are 18D1 and 4E44
respectively).

Use the sudo command to edit the 51-android.rules file located in the /etc/udev/rules.d directory. For
example:

sudo gedit /etc/udev/rules.d/51-android.rules

Within the editor, add the appropriate entry for the Android device, replacing <vendor_id> and
<product_id> with the vendor and product IDs returned previously by the /susb command:

SUBSYSTEM=="usb", ATTR{idVendor}=="<vendor id>",
ATTRS{idProduct }=="<product id>", MODE="0660", OWNER="root",
GROUP="androidadb", SYMLINK+="android%n"

Once the entry has been added, save the file and exit from the editor.
Next, use an editor to modify (or create if it does not yet exist) the adb_usb.ini file:
gedit ~/.android/adb usb.ini

Once the file is loaded into the editor, add the following lines (once again replacing <vendor_id> and
<product_id> with the vendor and product IDs returned previously by the Isusb command) before
saving the file and exiting:

Ox<vendor id>
Ox<product id>

Using the above syntax, the entries for the Nexus 7 would, for example, read:
0x18d1

Ox4ed4
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The final task is to create the androidadb user group and add your user account to it. To achieve this,
execute the following commands making sure to replace <user name> with your Ubuntu user account
name:

sudo addgroup --system androidadb
sudo adduser <username> androidadb

Once the above changes have been made, reboot the Ubuntu system. Once the system has restarted,
open a Terminal window, start the adb server and check the list of attached devices:

$ adb start-server

* daemon not running. starting it now on port 5037 *
* daemon started successfully *

$ adb devices

List of devices attached

015d41d4454bf80c offline

If the device is listed as offline or unauthorized, go to the Android device and check for the dialog
shown in Figure 7-4 seeking permission to Allow USB debugging.

7.3 Testing the adb Connection

Assuming that the adb configuration has been successful on your chosen development platform, the
next step is to try running the test application created in the chapter entitled Creating an Example
Android App in Android Studio on the device.

Launch Android Studio, open the AndroidSample project and, once the project has loaded, click on the
run button located in the Android Studio toolbar (Figure 7-5).

Build Run Toels VCS Window Help
AP ¥ & i [

5 120 layout f.? cunthfd_sample.xml
idroidSamplefctivity, java = & content_androi
Figure 7-5

Assuming that the project has not previously been configured to run automatically in an emulator
environment, the deployment target selection dialog will appear with the connected Android device
listed as a currently running device. Figure 7-6, for example, lists a Nexus 9 device as a suitable target
for installing and executing the application.
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% Select Deployment Target d

Connected Devices

HTC Mexus 9 (Android 7.1.1, API 25)

Available Virtual Devices

[0 Nexus 5X API 25 x86
[ Mexus 9 API 25

| Create New Virtual Device Don't see your device?
[:] Use same selection for future launches m | Cancel |
Figure 7-6

To make this the default device for testing, enable the Use same device for future launches option.
With the device selected, click on the OK button to install and run the application on the device. As
with the emulator environment, diagnostic output relating to the installation and launch of the
application on the device will be logged in the Run tool window.

7.4 Summary

While the Android Virtual Device emulator provides an excellent testing environment, it is important
to keep in mind that there is no real substitute for making sure an application functions correctly on a
physical Android device. This, after all, is where the application will be used in the real world.

By default, however, the Android Studio environment is not configured to detect Android devices as a
target testing device. It is necessary, therefore, to perform some steps in order to be able to load
applications directly onto an Android device from within the Android Studio development
environment. The exact steps to achieve this goal differ depending on the development platform being
used. In this chapter, we have covered those steps for Linux, Mac OS X and Windows based platforms.
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Chapter 8

8. The Basics of the Android Studio
Code Editor

Developing applications for Android involves a considerable amount of programming work which,
by definition, involves typing, reviewing and modifying lines of code. It should come as no surprise
that the majority of a developer’s time spent using Android Studio will typically involve editing code
within the editor window.

The modern code editor needs to go far beyond the original basics of typing, deleting, cutting and
pasting. Today the usefulness of a code editor is generally gauged by factors such as the amount by
which it reduces the typing required by the programmer, ease of navigation through large source code
files and the editor’s ability to detect and highlight programming errors in real-time as the code is
being written. As will become evident in this chapter, these are just a few of the areas in which the
Android Studio editor excels.

While not an exhaustive overview of the features of the Android Studio editor, this chapter aims to
provide a guide to the key features of the tool. Experienced programmers will find that some of these
features are common to most code editors available today, while a number are unique to this
particular editing environment.

8.1 The Android Studio Editor

The Android Studio editor appears in the center of the main window when a Java, XML or other text
based file is selected for editing. Figure 8-1, for example, shows a typical editor session with a Java
source code file loaded:
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S content_android_ssmplexml X | © menu_android_samplexml % | & activity_android_samplexml % | (€ AndroidSampleActivity.java % o

package com.ebookfrenzy.androidsample;
import ...

@ public class AndroidSampleRctivity extends AppCompatActivity |

onCreate (Bundles savedInstanceState) {

super.onCreate (savedInstanceState) ;

setContentView (R.layout.activity android sample);
Toolbar toolbar = {Toolbar) findViewById(R.id.toolbar):
setSupporthActionBar (toolbar) ;

FloatingActionButton fab = (FloatingActionButton) findViewById(R.id.fab); e
&l fab.setOnClickListener{(view) — | @

Snackbar.make(view, "Replace with your own action”, Snackbar.LENGTH LONG)
.setkction("Action”, mull).show():

Boverride
&1 public boolean onCreateCptionsMenu (Menu menu) {

getMenuInflater() .inflate (R.menu.menu_android sample, menu);
return true;

}

Boverride
&l public boolean onCptionsItemSelected(Menultem item) {
[T Cannot resolve symbol 'Bundles’ 1336 CRLF: UTF-8+ W 8 W

Figure 8-1
The elements that comprise the editor window can be summarized as follows:

A - Document Tabs — Android Studio is capable of holding multiple files open for editing at any one
time. As each file is opened, it is assigned a document tab displaying the file name in the tab bar located
along the top edge of the editor window. A small dropdown menu will appear in the far right-hand
corner of the tab bar when there is insufficient room to display all of the tabs. Clicking on this menu
will drop down a list of additional open files. A wavy red line underneath a file name in a tab indicates
that the code in the file contains one or more errors that need to be addressed before the project can
be compiled and run.

Switching between files is simply a matter of clicking on the corresponding tab or using the Alt-Left
and Alt-Right keyboard shortcuts. Navigation between files may also be performed using the Switcher
mechanism (accessible via the Ctrl-Tab keyboard shortcut).

To detach an editor panel from the Android Studio main window so that it appears in a separate
window, click on the tab and drag it to an area on the desktop outside of the main window. To return
the editor to the main window, click on the file tab in the separated editor window and drag and drop
it onto the original editor tab bar in the main window.

B — The Editor Gutter Area - The gutter area is used by the editor to display informational icons and
controls. Some typical items, among others, which appear in this gutter area are debugging breakpoint
markers, controls to fold and unfold blocks of code, bookmarks, change markers and line numbers.
Line numbers are switched off by default but may be enabled by right-clicking in the gutter and
selecting the Show Line Numbers menu option.

C — The Status Bar — Though the status bar is actually part of the main window, as opposed to the
editor, it does contain some information about the currently active editing session. This information
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includes the current position of the cursor in terms of lines and characters and the encoding format of
the file (UTF-8, ASCII etc.). Clicking on these values in the status bar allows the corresponding setting
to be changed. Clicking on the line number, for example, displays the Go to Line dialog.

D — The Editor Area — This is the main area where the code is displayed, entered and edited by the
user. Later sections of this chapter will cover the key features of the editing area in detail.

E — The Validation and Marker Sidebar — Android Studio incorporates a feature referred to as “on-
the-fly code analysis”. What this essentially means is that as you are typing code, the editor is analyzing
the code to check for warnings and syntax errors. The indicator at the top of the validation sidebar will
change from a green check mark (no warnings or errors detected) to a yellow square (warnings
detected) or red alert icon (errors have been detected). Clicking on this indicator will display a popup
containing a summary of the issues found with the code in the editor as illustrated in Figure 8-2:

Analysis completed

)

| 2 errors found
3 warnings found

n) findViewById(R.id.fab);

Figure 8-2

The sidebar also displays markers at the locations where issues have been detected using the same
color coding. Hovering the mouse pointer over a marker when the line of code is visible in the editor
area will display a popup containing a description of the issue (Figure 8-3):

Field 'my5String’ is never used

Figure 8-3

Hovering the mouse pointer over a marker for a line of code which is currently scrolled out of the
viewing area of the editor will display a “lens” overlay containing the block of code where the problem
is located (Figure 8-4) allowing it to be viewed without the necessity to scroll to that location in the
editor:

73



The Basics of the Android Studio Code Editor

1

L] public class AndroidSampleActivity extends AppCompatActivity {

String myString; |Field 'my3cring' is mewer used |

Boverride —

protected void onCreate(Bundles savedInstanceState) [ |Method 'onCreate(Bundles)' is never used || Cannot resolve symbol 'Bun|
super.onCreate (savedInstanceState) 7 | renCzeate (andreid.os.Bundle) ' in 'andreid.suppert.vl.app.AppCompathetivity’ cannot be

getContentView(R.layout.activity android sample);
Toolbar toolbar = (Toolbar) findViewById(R.id.toolbar);

Figure 8-4

It is also worth noting that the lens overlay is not limited to warnings and errors in the sidebar.
Hovering over any part of the sidebar will result in a lens appearing containing the code present at that
location within the source file.

Having provided an overview of the elements that comprise the Android Studio editor, the remainder
of this chapter will explore the key features of the editing environment in more detail.

8.2 Splitting the Editor Window

By default, the editor will display a single panel showing the content of the currently selected file. A
particularly useful feature when working simultaneously with multiple source code files is the ability
to split the editor into multiple panes. To split the editor, right-click on a file tab within the editor
window and select either the Split Vertically or Split Horizontally menu option. Figure 8-5, for example,
shows the splitter in action with the editor split into three panels:

& content_android_samplexm| x | ==3 | £ AndroidSampleActivity java *
<?xml version="1.0" encoding="utf-8"2> 4| package com.ebookfrenzy.androidsample; v
c <Relativelayout xmlns:android="http://schemas. andral

| umins:tools="http://schemas.android.com/tools" import android.os.Bundle;
xmins:app="http://schemas.android.com/ apk/resfai import android.support.design.widget.FloatingActionButton?
android:layout height="match parent" android:pai import android.support.design.widget.Snackbar;
android:paddingRight="1&dp" import android.suppeort.vw7.app.ApplompatActivity;
android:paddingTop="16dp" import android.support.v7.widget.Toolbar;
android:paddingBottom="16dp" import android.view.View;
app:layout behavior="android.support. deslc_m.\-=ir‘u! import android.view.Menu;
tools:showIn="flayout/activity android sample” import android.view.Menultem;
tools:context=".AndroidSampleActivity" |
android:background="#a0ff28"> ?4'3 public class AndroidSampleBActivity extends AppCompatActivity
<TextView | | e

android:layout width="wrap content" | | £ AndroidSampleActivity java * I
android:layout height="wrap content” |

1
android:textAppearance="7?android:attr/textly v
android: text="Welcome to Android Studio” foverride
android: id/textView" - R

| &1 public boolean onOpticnaltemSelected(Menultem item) |
android:layout centerVertical="true" B

android:layout centerHorizontal="true" />
</RelativelLayout>

R.id.actian settings) {
return true;

r De;\'gn. Text
Figure 8-5

The orientation of a split panel may be changed at any time by right-clicking on the corresponding tab
and selecting the Change Splitter Orientation menu option. Repeat these steps to unsplit a single
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panel, this time selecting the Unsplit option from the menu. All of the split panels may be removed by
right-clicking on any tab and selecting the Unsplit All menu option.

Window splitting may be used to display different files, or to provide multiple windows onto the same
file, allowing different areas of the same file to be viewed and edited concurrently.

8.3 Code Completion

The Android Studio editor has a considerable amount of built-in knowledge of Java programming
syntax and the classes and methods that make up the Android SDK, as well as knowledge of your own
code base. As code is typed, the editor scans what is being typed and, where appropriate, makes
suggestions with regard to what might be needed to complete a statement or reference. When a
completion suggestion is detected by the editor, a panel will appear containing a list of suggestions. In
Figure 8-6, for example, the editor is suggesting possibilities for the beginning of a String declaration:

public class AndroidSampleActivity extends AppCompatActivity |

sty

Srring (jawva.lang) "
tringTokenizer
trictHath

tringBuffer

tringBuilder

stringlndexfutlfBoundsException

R.id.fab}:

ckbar. IENGTH

Figure 8-6

If none of the auto completion suggestions are correct, simply keep typing and the editor will continue
to refine the suggestions where appropriate. To accept the top most suggestion, simply press the Enter
or Tab key on the keyboard. To select a different suggestion, use the arrow keys to move up and down
the list, once again using the Enter or Tab key to select the highlighted item.

Completion suggestions can be manually invoked using the Ctrl-Space keyboard sequence. This can be
useful when changing a word or declaration in the editor. When the cursor is positioned over a word
in the editor, that word will automatically highlight. Pressing Ctrl-Space will display a list of alternate
suggestions. To replace the current word with the currently highlighted item in the suggestion list,
simply press the Tab key.

In addition to the real-time auto completion feature, the Android Studio editor also offers a system
referred to as Smart Completion. Smart completion is invoked using the Shift-Ctrl-Space keyboard
sequence and, when selected, will provide more detailed suggestions based on the current context of
the code. Pressing the Shift-Ctrl-Space shortcut sequence a second time will provide more suggestions
from a wider range of possibilities.
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Code completion can be a matter of personal preference for many programmers. In recognition of this
fact, Android Studio provides a high level of control over the auto completion settings. These can be
viewed and modified by selecting the File -> Settings... menu option and choosing Editor -> General ->
Code Completion from the settings panel as shown in Figure 8-7:

) Settings X
T = " "
( ) Editor > General > Code Completion
Appearance & Behavior e
Appearance
A Case sensitive completion: First letter [ - |
System Settings Auto-insert when only one choice on:
File Colors &

Basic Completion ( Ctrl+Space )
Scopes
Notifications Smart Type Completion ( Ctrl+ Shift+Space )

Quick Lists
Keymap

[ Sort lookup items lexicographically

Fditor Autopopup code completion
General [ Insert selected variant by typing dot, space, etc.
Smart Keys
Appearance Autopopup documentation in (ms): 1000
Editor Tabs For explicitly invoked completion
Code Folding
Aute Import Autopopup in (ms): | 1000

Postfix Completion

Console Folding [C] Show full signatures

o« RN g
Figure 8-7
8.4 Statement Completion

Another form of auto completion provided by the Android Studio editor is statement completion. This
can be used to automatically fill out the parentheses and braces for items such as methods and loop
statements. Statement completion is invoked using the Shift-Ctrl-Enter (Shift-Cmd-Enter on Mac OS X)
keyboard sequence. Consider for example the following code:

protected void myMethod ()

Having typed this code into the editor, triggering statement completion will cause the editor to
automatically add the braces to the method:

protected void myMethod () {

}

8.5 Parameter Information

It is also possible to ask the editor to provide information about the argument parameters accepted
by a method. With the cursor positioned between the brackets of a method call, the Ctrl-P (Cmd-P on
Mac OS X) keyboard sequence will display the parameters known to be accepted by that method, with
the most likely suggestion highlighted in bold:
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String myButtonText = m‘gstring.replaceﬁllgb

String regularExpression, 5tring replacement

Figure 8-8
8.6 Code Generation

In addition to completing code as it is typed the editor can, under certain conditions, also generate
code for you. The list of available code generation options shown in Figure 8-9 can be accessed using
the Alt-Insert keyboard shortcut when the cursor is at the location in the file where the code is to be
generated.

Generate

toString()

Override Methods..,  Ctrl+0
Delegate Methods...

Super Method Call
Copyright

App Indexing APl Code

Figure 8-9

For the purposes of an example, consider a situation where we want to be notified when an Activity
in our project is about to be destroyed by the operating system. As will be outlined in a later chapter
of this book, this can be achieved by overriding the onStop() lifecycle method of the Activity superclass.
To have Android Studio generate a stub method for this, simply select the Override Methods... option
from the code generation list and select the onStop() method from the resulting list of available
methods:

= Select Methods to Override/Implement H

weElE = =
€ android.suppert.vT.app.ActionBarActivity
m b ActionBarActivity()
getSupportActionBar():ActionBar
getMenulnflater(:Menulnflater
setContentView(layoutReslDiint):void
setContentView(view:View):void
setContentViewlview:View, params:LayoutParam
addContentView(view:View, params:LayoutParan
enCenfigurationChanged (newConfig:Configurat
7 onStop():void
enPostResume(iveid
onCreatePanelView(featureld:int):View

onTitleChanged(title:CharSequence, colorintlvo

pp )tboc
supportinvalidateOptionsMenu(:void
onSupportActionModeStarted(mode:ActionMod
onSupportActionMedeFinished (mode:ActionMo
startSupportActionMode(callback Callback):Actic
ont

RN N T W VR N VE W] ) [N R T N VD

onPreparePanel(featureldint, view:View, menu:N/

[ Copy JavaDoc

¥ Insert @Override m Cancel |

Figure 8-10
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Having selected the method to override, clicking on OK will generate the stub method at the current
cursor location in the Java source file as follows:

@Override
protected void onStop () {
super.onStop () ;

}
8.7 Code Folding

Once a source code file reaches a certain size, even the most carefully formatted and well organized
code can become overwhelming and difficult to navigate. Android Studio takes the view that it is not
always necessary to have the content of every code block visible at all times. Code navigation can be
made easier through the use of the code folding feature of the Android Studio editor. Code folding is
controlled using markers appearing in the editor gutter at the beginning and end of each block of code
in a source file. Figure 8-11, for example, highlights the start and end markers for a method declaration
which is not currently folded:

_'-;-.'e::ijel

§ public boolean onCreatelptionsMenu(Menu menu) |

getMenuInflater().inflate (R.menu.android sample, menu);
return true;

Clicking on either of these markers will fold the statement such that only the signature line is visible

La)
H
i
i

Figure 8-11

as shown in Figure 8-12:

& S
WL gl i il e

&) public boolean onCreatelptionsMenu{Menu menu) [...}

Figure 8-12

To unfold a collapsed section of code, simply click on the ‘+' marker in the editor gutter. To see the
hidden code without unfolding it, hover the mouse pointer over the “{...}” indicator as shown in Figure
8-13. The editor will then display the lens overlay containing the folded code block:
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\/

i public boolean on{reatelptionsMenu(Menu menu) {...}

i public boolean on{reatelptionsMenu(Menu menu) {

getMenuInflater() .inflate (R.menu. android sample, menu);
return true;

INt 1d = 1tem.gecltemld(] s
if (id == R.id.action settings) {

Figure 8-13
All of the code blocks in a file may be folded or unfolded using the Ctrl-Shift-Plus and Ctrl-Shift-Minus

keyboard sequences.

By default, the Android Studio editor will automatically fold some code when a source file is opened.
To configure the conditions under which this happens, select File -> Settings... and choose the Editor -
> General -> Code Folding entry in the resulting settings panel (Figure 8-14):

) Settings X

(Q ) Editor > General > Code Folding

Appearance & Behavior Show code folding outline
ey Collapse by default:
Editor
Gereral Ed File header
Smart Keys Ed imports
Appearance [C] Documentation comments
Editor Tabs

Method bod
Cone Folding WS

Code Completion [ Custom folding regions

Auto Import
o mpe [ XML tags

Postfix Completion
HTML 'style’ attribute

Console Folding

Colors & Fonts .
(] Infine parameter names for literal call arguments

Code Style
et ; One-line methods

File and Code Templates T (] Simple property accessors

File Encodings B (] Inner classes

kit [ Anoriymous classes

helies [ Annotations

Copyright

it B2 "Closures" (anonymous classes implementing one method, before Java 8)
Images EA Generic constructor and method parameters

micaml” | [ Hetp |
Figure 8-14
8.8 Quick Documentation Lookup

Context sensitive Java and Android documentation can be accessed by placing the cursor over the
declaration for which documentation is required and pressing the Ctr/-Q keyboard shortcut (Ctrl-J on
Mac OS X). This will display a popup containing the relevant reference documentation for the item.
Figure 8-15, for example, shows the documentation for the Android Menu class.
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FloatingActionButton fab = (FloatingActionButton) findViewById(R.id.f

fab Documentation for FloatingActionButton >
B ] il design-23.1.0 %
android.support.design.widget r.

puklic class FloatingActionButton
extends android.widget.ImageButton

Floating action buttons are used for a special type of promoted action.
They are distinguished by a circled icon floating above the UI and have
| special motion behaviors related to morphing, lunching, and the

Figure 8-15

Once displayed, the documentation popup can be moved around the screen as needed. Clicking on
the push pin icon located in the right-hand corner of the popup title bar will ensure that the popup
remains visible once focus moves back to the editor, leaving the documentation visible as a reference
while typing code.

8.9 Code Reformatting

In general, the Android Studio editor will automatically format code in terms of indenting, spacing and
nesting of statements and code blocks as they are added. In situations where lines of code need to be
reformatted (a common occurrence, for example, when cutting and pasting sample code from a web
site), the editor provides a source code reformatting feature which, when selected, will automatically
reformat code to match the prevailing code style.

To reformat source code, press the Ctrl-Alt-L keyboard shortcut sequence. To display the Reformat
Code dialog (Figure 8-16) use the Ctrl-Alt-Shift-L. This dialog provides the option to reformat only the
currently selected code, the entire source file currently active in the editor or only code that has
changed as the result of a source code control update.

¥ Reformat File: AndroidSampleActivity.java *
Scope: Optienal:
_ [ Optimize imports
] Rearrange code

© Wholefile

m | Cancel | | Help |

Figure 8-16

The full range of code style preferences can be changed from within the project settings dialog. Select
the File -> Settings menu option and choose Code Style in the left-hand panel to access a list of
supported programming and markup languages. Selecting a language will provide access to a vast array
of formatting style options, all of which may be modified from the Android Studio default to match
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your preferred code style. To configure the settings for the Rearrange code option in the above dialog,
for example, unfold the Code Style section, select Java and, from the Java settings, select the
Arrangement tab.

8.10 Finding Sample Code

The Android Studio editor provides a way to access sample code relating to the currently highlighted
entry within the code listing. This feature can be useful is learning how a particular Android class or
method is used. To find sample code, highlight a method or class name in the editor, right-click on it
and select the Find Sample Code menu option. The Find Sample Code panel (Figure 8-17) will appear
beneath the editor with a list of matching samples. Selecting a sample from the list will load the
corresponding code into the right-hand panel:

Find Sample Code - L
% v Symbol e public boolean onOptionsItemSelected (Menultem item) {
& op Activity.onOptionsitemSelected 49 switch (item.getItemId()) {
e et : 50 case R.id.action info:
i By s1 new AlertDislog.Builder (this)
¥ .Andia Deveonsts 52 .setMessage (R.string.intro_message)
gle android-PdfRendererBasic 53 .setPositiveButton (android.R.atring.ok, mull)
| ¢ MainActivityjava (1 resutt) 54 .show():
e - android-NavigationDrawer 55 return true;
[ NavigationDrawerActivity.java 3 56 1
57 return super.onCptionsltemSelected (item):
= google-api-java-client-samples - ,
[ CloudMotesActivityjava ulk e i
[P TasksSamplejava (1 re &0
[ CalendarSampleActivityjava &1
be/yt-direct-lite-android
[ Main Acthits ime (1 =
Figure 8-17

8.11 Summary

The Android Studio editor goes to great length to reduce the amount of typing needed to write code
and to make that code easier to read and navigate. In this chapter we have covered a number of the
key editor features including code completion, code generation, editor window splitting, code folding,
reformatting and documentation lookup.
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Chapter 9

9. An Overview of the Android
Architecture

So far in this book, steps have been taken to set up an environment suitable for the development
of Android applications using Android Studio. An initial step has also been taken into the process
of application development through the creation of a simple Android Studio application project.

Before delving further into the practical matters of Android application development, however, it is
important to gain an understanding of some of the more abstract concepts of both the Android SDK
and Android development in general. Gaining a clear understanding of these concepts now will provide
a sound foundation on which to build further knowledge.

Starting with an overview of the Android architecture in this chapter, and continuing in the next few
chapters of this book, the goal is to provide a detailed overview of the fundamentals of Android
development.

9.1 The Android Software Stack

Android is structured in the form of a software stack comprising applications, an operating system,
run-time environment, middleware, services and libraries. This architecture can, perhaps, best be
represented visually as outlined in Figure 9-1. Each layer of the stack, and the corresponding elements
within each layer, are tightly integrated and carefully tuned to provide the optimal application
development and execution environment for mobile devices.

The remainder of this chapter will work through the different layers of the Android stack, starting at
the bottom with the Linux Kernel.
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Applications

‘ Native Android Apps - Third Party Apps il

Application Framework
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Manager Manager Manager System
( Locaton Y (" Package Y [ v
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Manager
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SQLite WebkKit | OpenGLES |

| Android Runtime

Y Ssurface Media ART
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Linux Kernel
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Driver \  Driver  J\  Drivers ! Drivers

Camera " Power " Process Memory :'
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Figure 9-1

9.2 The Linux Kernel

Positioned at the bottom of the Android software stack, the Linux Kernel provides a level of abstraction
between the device hardware and the upper layers of the Android software stack. Based on Linux
version 2.6, the kernel provides preemptive multitasking, low-level core system services such as
memory, process and power management in addition to providing a network stack and device drivers
for hardware such as the device display, Wi-Fi and audio.

The original Linux kernel was developed in 1991 by Linus Torvalds and was combined with a set of
tools, utilities and compilers developed by Richard Stallman at the Free Software Foundation to create
a full operating system referred to as GNU/Linux. Various Linux distributions have been derived from
these basic underpinnings such as Ubuntu and Red Hat Enterprise Linux.

It is important to note, however, that Android uses only the Linux kernel. That said, it is worth noting
that the Linux kernel was originally developed for use in traditional computers in the form of desktops
and servers. In fact, Linux is now most widely deployed in mission critical enterprise server
environments. It is a testament to both the power of today’s mobile devices and the efficiency and
performance of the Linux kernel that we find this software at the heart of the Android software stack.
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